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Chapter 1: Introduction to the Basics User 
Guide 
 

This section contains the following topics: 

Quick Tour of CA Clarity PPM (see page 11) 
 

Quick Tour of CA Clarity PPM 

This guide assumes that you are a nonadministrative CA Clarity PPM user who has the 
appropriate access rights to perform basic functions. 

 

The procedures that are described are for CA Clarity PPM with no customization. Your 
procedures can vary. For example, you can have personalized changes, or your 
administrator can modify the user interface. 
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The following graphic shows the default home page and its main components. 

 
 

Main Menu 

Move the cursor over the following features on the main menu to see a tooltip that 
identifies the feature. 

 

1–Back 

Returns you to the previous page, which is based on the previous entry in the 
Recent Pages list. 
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2–Recent Pages (History) 

Provides a drop-down list of the pages most recently viewed. You can select from 
the list to return to a page. Entries are not made for navigation between subpages 
that belong to a specific instance. For example, if you are navigating between the 
subpages of a specific project, the subpages are not listed in the Recent Pages list. 

 

3–Home, Administration, and Favorites Menus 

Provide the navigation to all the CA Clarity PPM pages. The menus and options that 
you can view depend on your access rights.  

 

4–Refresh 

Updates the data on a page. 
 

5–Home 

Returns you to the home page. 
 

6–Current Timesheet 

Takes you to your current open timesheet. 

7–Search 

Opens a search window for CA Clarity PPM. 
 

User Toolbar 

The User toolbar always appears at the top of the page. 

 

To access the following functions, use the links on the toolbar. The following fields 
require explanation: 

About 

Provides information about the CA Clarity PPM version, the logged-in user, and 
third-party software. 

 

Learn (Optional) 

Presents the CA PA training modules for your organization. The link displays only if 
CA PA is set up for your organization. 
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Page Icons 

The icons provide quick access to frequently used functions on a page. Not all icons 
appear on all pages. The icons appear only if the functions they represent are available 
for the page. 

 

Export to Excel 

Exports information from a portlet on a page to an Excel file.  

Note: The Export to Excel command often appears under the Options menu for a 
portlet. 

Export to PowerPoint 

Exports content from a page to a PowerPoint format. The icon appears only if the 
page has portlets. 

Personalize 

Allows you to customize a page by adding or removing a portlet, adding or 
removing a filter, or changing the layout of portlets. 

Manage My Tabs 

Allows you to create new tabs, add content to tabs, and change the layout of 
portlets on tabs. 
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Overview Page Portlets 

A portlet provides a snapshot of specific CA Clarity PPM data. A portlet can appear as a 
list, a chart, or a snippet of HTML. You can filter and select the data that appears in a 
portlet. 

The Overview page contains portlets that help you access data. The following fields 
require explanation: 

Action Items 

Provides a list of action items that are assigned to you. 

Favorite Links 

Provides a list of internal CA Clarity PPM links you save. 

My Projects 

Provides a list of projects you select for easy access from this portlet. 

Notifications 

Provides a list of notifications that are sent to you. 

Site Links 

Provides a list of external internet sites you save. 
 

Tab Menus 

Some tabbed pages have menus on the tabs. Tabs with menus display an arrow.  

Click the tab once to open the menu and view the menu options.  

The following graphic shows the open Team tab and its menu. 
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Smart Sections 

You can manage pages with many sections and fields. A section header bar acts as a 
switch button to open or close the section. Also, the section header bar contains a 
Required icon for the sections with errors. 

■ To open or close all sections on a page, double-click any section header bar. 

■ To open or close a single section, click the section header bar once. 

■ The header bars for any sections that contain errors are highlighted when you save.  

If all sections are collapsed, the first highlighted section is expanded for you to 
make corrections. To make corrections in any remaining highlighted sections, click 
the section header bar to open the section. 

■ Any section that contains required fields displays the Required icon on the header 
bar. This display lets you scan collapsed sections to see which ones contain required 
fields. 
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Chapter 2: Getting Started 
 

This section contains the following topics: 

Home Menu (see page 17) 
Set a Home Page (see page 18) 
View Your Information (see page 18) 

 

Home Menu 

The Home menu is the main menu for CA Clarity PPM users. The following illustration 
shows the Home menu expanded. To open and expand the menu, move the pointer 
over the menu name. 

 
 

The menu options that appear on the Home menu depend on the rights that are 
granted to you. The menu selections can vary for each user. 

The menu includes the following features: 

Previous and Next  

Scrolls to the right or the left when clicked. If the Next button is active (bold), more 
menus appear to the right on the menu. If the Previous button is active, more 
menus appear to the left. 

 

Set as Home 

Sets the currently open page as your home page. 

Reset Home 

Resets the home page to the default home page, the Overview page. 

Refresh 

Updates the menu to include recent changes. 
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Set a Home Page 

The default home page is the Overview page. You can set any page as the home page. 

Follow these steps: 

1. Navigate to the page you want as the new home page. 

2. Open Home and click Set as Home at the bottom of the menu. 

You can reset the home page to the default Overview page by opening Home and 
clicking Reset Home. 

 

View Your Information 

To view your information, open one of the following pages: 

Overview 

Open the Home menu and from Personal, click General. 

Overview is the default home page. This page contains portlets that list your action 
items and notifications. This page also contains portlets to which you can add: 

■ Personal links for easy access to projects 

■ Pages inside CA Clarity PPM 

■ External internet addresses 

■ Favorite photos 
 

Organizer 

Open the Home menu and from Personal, click Organizer. This page contains 
detailed information about your action items, notifications, processes, and tasks. 

■ Action Items (see page 19) 

■ Notifications (see page 20) 

■ Processes (see page 20) 

■ Tasks (see page 22) 
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Action Items 

Action Items are nontasks that you assign to yourself, or others assign to you. You can 
use action items to track the progress of projects and to ensure that a project is 
complete and on time. 

You can create both personal and project-related action items. You create personal 
action items from the Organizer page and project-related action items from within a 
project. The Action Items tab on the Organizer page lists all of the personal and 
project-specific action items that you create. The Action Items tab also lists action items 
that others create and assign to you. 

 

Create an Action Item 

You are the owner of action items you create. As the owner, you can modify or delete 
an action item. You can modify the properties of a personal action item you create from 
the Action Item Properties page. For an action item assigned to you by another user, 
you can update only the status. 

Follow these steps: 

1. Open Home, and from Personal, click Organizer.  
 

2. Click New.  
 

3. Complete the information in the General section. The following fields require 
explanation: 

 

 

 
 

Recurring 

Indicates if the action item occurs at regular intervals. 
 

Frequency 

Specifies how often the action item reoccurs. 

Example: Enter 1 to create a status report each week. 
 

 

Until 

Indicates the last date on which you want the action item to reoccur. 
 

4. Complete the information in the Notify section. The following fields require 
explanation: 

Notify Assignees 

Indicates if a notification has to be sent. 
 

Send Reminder 

Indicates if a reminder email notification has to be sent to the assigned 
resources when the action item is due. 
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Time Before Reminder 

Defines the amount of time before an item is due that the reminder occurs. For 
example, enter 15, and select Minutes in the Units field. 

 

Units 

Specifies the unit of time for the reminder if the Send Reminder check box is 
selected. 

 

5. Enter the name of the resource to assign the action item in the Assignees section 
and save your changes. 

 

Open an Action Item from Notifications 

A notification can be an alert, an email, or an SMS message that notifies you of new 
activities or changes in CA Clarity PPM. You can see alerts for your assigned action items 
or overdue timesheets. 

Alert notifications appear on the Overview page (Notifications portlet) and the 
Organizer page (Notifications tab). 

You can open an action item from the notification list. 

Follow these steps: 

1. Open Home, and from Personal, click Organizer. 

2. Click Notifications. 
 

3. Click the link in the Message column or the Properties icon that displays next to the 
alert notification. 

 

Available and Initiated Processes 

A process is a series of actions or steps in the product. 

Note: Processes are not explicitly marked as complete. The completeness of a process 
instance depends on the status of the steps it contains. When the Finish step is 
completed, the process instance ends. 
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You can view the following processes from the Organizer: 

■ Initiated 

Includes process instances that you started or to which you have the view access. 
You can view the status or click a process link to view the step details. 

■ Available 

Includes processes available for you to start and edit. You can also create new 
processes. 

Note: To view a list of all available global processes, process administrator access is 
required. 

 

Manage Processes 

You can start, modify, or cancel a process. Each time a process is started, by either a 
manual action or an automated trigger, a process instance is created. You can only 
modify processes that have Mode set to Draft or On Hold. The appropriate access rights 
are required to modify a process. You can cancel only active and incomplete processes. 
Canceled process instances are not deleted automatically and remain for reference 
purposes. 

Follow these steps: 

1. Open Home, and from Personal, click Organizer. 

2. Click Processes. 
 

3. Open the Processes menu and perform one of the following actions. 

4. Start a process. 

a. Click Available. 

b. Select the check box next to the process you want to start, and click Start. 
 

5. Modify a process. 

a. Click Available. 

b. Click the name of the process that you want to modify. 
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c. Complete the following steps: 

■ Modify the generic attributes for this process. 

■ Update the process steps as desired by adding, renaming, deleting, adding 
conditions to, or altering actions. 

■ Update groups by adding, removing, reorganizing, or renaming them. 

■ Update escalation properties by changing escalation type, level, grace 
period, or additional notifications. 

■ Click the Validation link to validate the process modifications. If you 
identify any errors, correct them and revalidate the process. If there are no 
errors, click Exit. 

 

6. Cancel a process. 

a. Click Initiated. 

b. Select the process instance, and click Cancel Process. 

c. Click Yes to confirm. 
 

Tasks 

A personal task is a work item for which you can log work in your timesheet and can 
track the progress. You can view personal tasks that you create and those others assign 
to you. A task entry appears in the task list for each assigned task. You can perform the 
following actions with tasks: 

■ Open and view the task 

■ Edit the displayed task properties 

■ Mark a task as complete or not complete 

You can update a personal or assigned task to ensure that information about tasks is 
up-to-date. 

Follow these steps: 

1. Open Home, and from Personal, click Organizer. 
 

2. Click Tasks. 

3. Open the task that you want to update. The following fields require explanation: 
 

Task 

Defines the name of the task. The value for the field is derived from the Name 
field on the Task Properties page. On list pages or in portlets, displays the name 
of the task. 

Limits: 64 characters 
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Investment 

Displays the name for the investment. The value for this field is based on the 
Project Name field on the Project Properties page. 

 

Start 

Defines the date to start the task assignment for a resource. The list pages or 
portlets display the start date. 

Default: Task start date 

Note: Define the assignment to start on or after the task start date. If an 
assignment has actuals, the field is read-only. 

 

Finish 

Defines the date to complete the task assignment for a resource. The list pages 
and portlets display this completion date. 

Default: Task completion date 

Note: Define the assignment to finish on or before the task completion date. 
 

Actuals 

Displays the total work units that a resource worked and posted to the task 
assignment. 

 

Pending Actuals 

Displays the number of hours that a resource entered on a timesheet. Pending 
actuals can be displayed on a timesheet with a status of Open, Saved (by 
Resource), Submitted, or Approved. 

 

ETC 

Displays the estimated hours to complete the task. Click in the cell to edit the 
value. 

 

Assignment Status 

Displays the status of the task. The value for this field is derived from the Status 
field on the Task Properties page.  

Values: 

■ Not Started. No time is posted against the task. 

■ Started. Automatically changes the status to Started when time is posted 
against the task. 

■ Completed. Automatically changes the status to Completed when the task 
ETC has zero hours and the task status is updated to Completed. 

 

4. Save your changes. 
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Chapter 3: How to Add and Manage Your 
Favorites 
 

This section contains the following topics: 

CA Clarity PPM Favorites (see page 25) 
Add a Favorites Page Link (see page 25) 
Add a Favorites Action Link (see page 26) 
Add a Favorites Menu Section (see page 26) 
Reorder Menu Sections (see page 27) 
Remove a Menu Section or Link (see page 27) 

 

CA Clarity PPM Favorites 

Favorites is a personal menu that you can use to store the links you use every day. This 
menu lets you store a link to any page as a favorite for easy access at any time. 

You can save any product page as a favorite. These favorites are specific to CA Clarity 
PPM pages and are different from the browser favorites. CA Clarity PPM also lets you 
organize your favorites by adding page links, action links, and menu sections.  

To save a page as a favorite, open the page, select the CA Clarity PPM Favorites menu, 
and click Add Current. 

 

Add a Favorites Page Link 

You can add a page link to the Favorites menu. 

Follow these steps: 

1. Open Favorites, and click Configure. 
 

2. Click Add. 

3. Select Page Link and click Next. 

4. Complete the requested information: 

Link Name 

Defines the label for the page link that appears in the menu. 
 

Description  

Defines the purpose for the section or page link. 
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Page Name  

Specifies the page that appears when the link is clicked. 
 

Parent Menu Item  

Specifies the menu section in which the link appears. 

5. Save your changes. 
 

Add a Favorites Action Link 

You can add an action link to the Favorites menu. When you click an action link, a 
specified action occurs. 

Follow these steps: 

1. Open Favorites, and click Configure. 
 

2. Click Add. 

3. Select Action Link and click Next. 

4. Complete the requested information. The following fields require explanation: 

Link Name 

Defines the name of the link for the action. The link name is the label that 
displays in the menu. 

 

 

Action Name 

Specifies the action that occurs when the link is clicked in the menu.  
 

Parent Menu Item 

Specifies the section in which the link appears. 

5. Save your changes. 
 

Add a Favorites Menu Section 

You can add a section to the Favorites menu so that you can organize your saved 
favorite pages. 

Follow these steps: 

1. Open Favorites, and click Configure. 

2. Click Add. 
 



Reorder Menu Sections 

 

Chapter 3: How to Add and Manage Your Favorites  27  
 

3. Select Section and click Next. 

4. Complete the requested information. 

5. Save your changes. 
 

Reorder Menu Sections 

You can reorder sections and links in the Favorites menu.  

Follow these steps: 

1. Open Favorites, and click Configure. 

2. Click Reorder. 
 

3. Select a section in the Menu Items list, and click the arrows to move the section to a 
new position. 

4. Save your changes. 

Note: If you do not see your changes reflected in the menu, click the Refresh button. 
 

Remove a Menu Section or Link 

You can remove a menu section, page link, or action link. You can only remove sections 
or links that you have created. You cannot remove the CA Clarity PPM default sections 
or links.  

To remove a section or link, open Favorites, click Configure, and select and remove a 
section or link. 
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Chapter 4: How to Manage Your Account 
Settings 
 

This section contains the following topics: 

CA Clarity PPM Account Settings (see page 29) 
Manage Your Personal Information (see page 29) 
Update Your Password (see page 30) 
Designate Proxies (see page 30) 
Set Up Notifications (see page 31) 
Download Software (see page 32) 

 

CA Clarity PPM Account Settings 

Your personal CA Clarity PPM account settings let you manage the following items: 

■ Password and contact information 

■ Action items proxy 
 

■ Method of receiving notifications 

■ Client software downloads 

To access your account settings, open Home, and from Personal, click Account Settings. 
 

Manage Your Personal Information 

You can use the Personal Information page in Account Settings to perform the following 
tasks: 

■ Update your contact and password information 

■ Reset your home page 

■ Set the current timesheet as your home page 
 

Follow these steps: 

1. Open Home, and from Personal, click Account Settings. 

2. Complete the requested information in the General Information section. The 
following fields require explanation: 

Time Zone 

Defines the primary workplace time zone. 
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Locale 

Defines your work locale. The locale controls the number and date language 
formatting in the product. 

Default: English (United States) 
 

Language 

Defines the language to use in the product. The language that is selected here 
also applies to the Business Objects reports for the resource. 

Note: A change in the language can take a few minutes to reflect. You can wait 
or log in at a later time to see the changes. 

Default: English 
 

3. Save your changes. 
 

Update Your Password 

You can include an unlimited number of characters in your password. 

Best Practice: Select a combination of letters and numbers to ensure that your 
information remains secure. 

Follow these steps: 

1. Open Home, and from Personal, click Account Settings. 

2. Complete the old, new, and confirm password fields in the Change Password 
section, and save your changes. 

Note: The Change Password section does not appear for the following reasons: 

■ Your administrator did not grant you the Account Settings - Navigate access 
right. This right is required to navigate to the Account Settings page.  

■ Your administrator has enabled external authentication such as LDAP or SSO. In 
these configurations, contact your administrator to learn how to change your 
external login credentials. 

 

Designate Proxies 

You can temporarily designate another resource as your action items proxy using the 
Proxy page in Account Settings. The assigned resource receives action items, such as 
your regularly scheduled or urgent action items, during the specified proxy period. 

During the period that an action item is due, the designated proxy sees the action item 
in the Action Items portlet on the Overview page. 
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Important! Verify that the resource designated as your action items proxy has the 
appropriate access rights for the actions they must process. For example, if you 
designate a proxy to receive action items to approve timesheets, the proxy requires the 
Timesheets - Approve All right. 

 

Follow these steps: 

1. Open Home, and from Personal, click Account Settings. 

2. Click Proxy. 

3. Complete the requested information in the Setup section, and save your changes. 
 

View Your List of Proxies 

If other resources have designated you as their action items proxy, their names appear 
in the Resources field on the Proxy page of Account Settings. Any action items that 
become due during the proxy period display in your Action Items portlet on the 
Overview page. One or more resources can designate you as a proxy. 

 

Set Up Notifications 

Notifications are automatically generated when certain actions are triggered. You can 
view and manage the method in which you receive your notifications when their 
associated events are triggered. For example, you can set up notification by email when 
someone responds to an action item. 

Use the Notifications page in Account Settings to specify or change the types of 
notifications you want to receive. You can also specify the method to receive 
notifications. All the method check boxes for each functional area are selected by 
default. 

 

The following list describes examples of situations that trigger notifications for each 
functional area: 

Action Items 

A notification is sent out when a new action item is assigned to you and when one is 
due. 

 

Change Request 

A notification is sent when you are assigned to a change request. 
 

Escalation 

A notification is sent when a process fails or stalls and you are identified as the 
person to notify for escalations. 
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Issues 

A notification is sent when you are assigned to an issue. 
 

Processes 

A notification is sent when a resource identifies you as the person to contact for a 
certain step in a process. 

 

Projects 

A notification is sent when a resource adds you to or removes you from a project. 
 

Reports and Jobs 

A notification is sent when a report or job you initiated, scheduled, or are assigned 
to is completed or failed. 

 

Risks 

A notification is sent when you are assigned to a risk. 
 

Timesheets 

A notification is sent when you receive a notification for a submitted timesheet. You 
can receive a notification that a timesheet is overdue or is returned. 

 

Follow these steps: 

1. Open Home, and from Personal, click Account Settings. 

2. Click Notifications. 

3. Select the functional areas and methods to receive notifications. 

4. Save your changes. 
 

Download Software 

The CA Clarity PPM administrator sets up the installation files on the CA Clarity PPM 
server. To download software, you require: 

■ Access rights to download the software. 

■ Administrator rights to install the software. 

Note: Even if you have the appropriate access rights, the software may not be available. 
Make a note of the folder location to which you install the software. 

 

You can download the following software from CA Clarity PPM: 

Open Workbench 

This application is desktop project management software. You can use Open 
Workbench as a stand-alone software application or with CA Clarity PPM. 
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Microsoft Project Interface 

Use CA Clarity PPM Microsoft Project Interface to connect Microsoft Project with 
CA Clarity PPM. 

Java Runtime Environment 

Use Java Runtime Environment to use XML Open Gateway (XOG) to pass data 
between CA Clarity PPM and other programs. 

 

Adobe SVG Viewer 

Allows you to view graphical portlets and processes. 
 

SAP BusinessObjects Xcelsius 2008 

Use Xcelsius to create visualizations and to set up the data connections. Download 
and install the Xcelsius locally on your computer.  

Note: For this download link to display on the Software Downloads page, you 
require access rights to install Xcelsius. In addition, the CA Clarity PPM 
administrator must copy the Xcelsius setup zip file to a CA Clarity PPM install folder. 

Contact your CA Clarity PPM administrator if you are unable to download Xcelsius. 
 

CA Clarity UI Themes as Xcelsius Color Schemes 

Gives the Xcelsius visualizations the same colors as your portlets and pages in CA 
Clarity PPM. The CA Clarity PPM UI themes are available to use in Xcelsius 
visualizations. 

Follow the instructions on the Software Downloads page to make the UI themes 
available as Xcelsius color schemes. 

 

Design Files for Stock Xcelsius Visualizations 

Helps you get started with sample implementations. You can use the Xcelsius 
visualizations design files (.XLF) as is, or you can use them as a starting point to 
design your own Xcelsius visualizations. 

Note: For more information about Xcelsius, see the CA Clarity-Xcelsius 
Implementation Guide. 

 

 

Follow these steps: 

1. Open Home, and from Personal, click Account Settings. 

2. Click Software Downloads. 
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3. Click the Download link corresponding to the software. 

Depending on the software you select, a series of file download, "Save As", and 
install windows open. 

4. Follow the download instructions. 

Note: See your CA Clarity PPM administrator for any assistance if you are unable to 
download the required client software. In addition, contact your administrator if you 
have questions about the download process. 
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Chapter 5: How to Personalize CA Clarity 
PPM 
 

This section contains the following topics: 

Personalizing CA Clarity PPM (see page 35) 
How to Personalize Pages (see page 35) 
Present a Page as a Pop-up (see page 39) 
How to Work with Lists (see page 40) 

 

Personalizing CA Clarity PPM 

You can personalize pages, lists, charts, filters, and personal dashboards. The changes 
that you make are visible only to you.  

If you have the privileges to personalize, the related menus or icons appear on a page or 
a portlet toolbar. If the owner changes and publishes the original item, you lose your 
personal changes. 

 

The information in this section is based on the out-of-the-box version of CA Clarity PPM. 
If you or your administrator create user-defined values and fields or you configure a 
page or portlet, the procedures can be different. 

You can configure lists, charts, and filter portlets that appear on pages, tabs, or 
dashboards in CA Clarity PPM.  

 

How to Personalize Pages 

You can personalize your pages so that they display the information you need. By 
personalizing a page, you view only the content that is relevant to your task. You can 
display the content on the page in a way that best suits you. The changes that you make 
are visible only to you. 

Each CA Clarity PPM page is composed of portlets, and the page content can be 
organized into tabs. 

 



How to Personalize Pages 

 

36  Basics User Guide 
 

The following diagram describes how an application user personalizes pages: 

 

Follow these steps: 

1. Review the Prerequisites (see page 36) 

2. Manage Page Content (see page 37) 
 

3. Add a Filter to a Page (see page 37) 

4. Manage Page Layouts (see page 38) 

5. Manage Page Tabs (see page 38) 
 

Review the Prerequisites 

To complete all tasks, consider the following items: 

■ You must have sufficient access rights.  

Note: If you have the privileges to personalize, the related menus or icons appear 
on a page or a portlet toolbar. 

■ The page must allow edits. Your CA Clarity PPM administrator must enable the 
Allow users to add tabs and Personalize. 
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Add and Manage Page Content 

You can manage the page content by adding or removing portlets, or restoring default 
portlets. 

Follow these steps: 

1. Click the Personalize icon that is at the right top corner of the page. 

The Content page appears with a list of portlets that are already displayed on the 
page. 

2. Click Add and in the Select Content dialog, select the portlets that you want to add 
to the page. 

 

3. Complete one of the following steps: 

■ Click Add or Add and Select More. 

■ Click Return to save the changes and return to the page.  

■ Click Continue to make further configuration settings. 

To remove portlets from the page or restore the default content, use the Remove or 
Restore Defaults buttons. 

 

Add a Page Filter 

You can add a filter portlet to a page to filter the page content. 

Follow these steps: 

1. Click the Personalize icon at the right top corner of the page. 

2. Select the Page Filters tab. 
 

3. Click Add and select a filter from the list. 

4. Click Add. 
 

5. (Optional) Set the Persist and Default options. 

Persist 

Allows the values in the filter to persist when you move from one page to 
another. The filter values persist only across pages that use the same filter 
portlet. 

Default 

Sets the page filter default. The first filter that is published to the page is the 
page filter default unless a selection indicates otherwise. 

6. Save your changes. 
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Manage Page Layouts 

Change the layout of the page by reordering the page content. 

Follow these steps: 

1. Click the Personalize icon that is at the right top corner of the page. 

2. Select the Layout tab. 
 

3. Select the layout template for the portlets in the Layout field. 

Each option provides the number of columns and the percentage of the page that is 
given to each column. In the Row Layout option, the number of portlets you place 
in a row determines the percentage of space that is given to a portlet. 

 

4. Use the arrow keys to move the portlets in the order you want for the page. 

5. Save your changes. 
 

Manage Page Tabs 

You can create your personalized workspace by managing the tabs that appear on a 
page and the portlets that appear on each tab. 

You can perform the following actions to manage tabs: 

■ Add new tabs and select the portlets for these tabs (see page 38). 

■ Edit, reorder, or delete tabs (see page 39). 
 

Add a New Tab and Tab Content 

Add a tab to a page, and then add the portlets you want displayed on the page. The new 
tab that you add appears as the last tab on the page. 

Follow these steps: 

1. On your current page, click the Manage My Tabs icon. 

2. Click New. 
 

3. Complete the Tab Name and Description fields and click Save and Continue. 

4. Add and manage the page content (see page 37) that you want on the new tab, and 
click Continue. 

 

5. Add a page filter (see page 37) and click Continue. 

6. Configure the layout (see page 38) and click Save and Return. 
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Edit Tabs 

Edit the properties and content of existing tabs. 

Note: You cannot edit the properties of all tabs. A tab that you can edit shows a link 
when you hover the mouse cursor over the list. You can edit the properties of custom 
tabs you create. 

Follow these steps: 

1. Click the Manage Project Tabs icon on your current page. 

2. On the Manage Tabs page, click the name of the tab that you want to edit. 
 

3. You can edit: 

■ Page properties 

■ Page content (see page 37) 

■ Filters (see page 37) 

■ Page Layout (see page 38) 

4. Save the changes. 
 

On the Manage Tabs page, you can also delete selected tabs or reorder them. Use the 
respective buttons. 

Note: You can remove the tabs that you create on a page. You cannot remove the CA 
Clarity PPM default tabs, or the tabs that are installed with the PMO Accelerator add-in. 

 

Present a Page as a Pop-up 

Some lists display a Configuration icon in the Options toolbar. For these lists, you can set 
items that are selected from the list to display in a separate pop-up that floats above the 
workspace. A pop-up is one way to provide a visual reminder of where you are in the 
application. The popup has the same functionality as a page presented in the 
workspace. 

Note: When you set an item on a list page to appear in a pop-up, all list items on that 
page are set to appear in a pop-up. 

 

Follow these steps: 

1. Open the list page that you want to configure. 

For example, open Home, and from Portfolio Management, click Projects.  

2. Click the Options icon to open the menu, and click Configure.  

3. Open the List Column Section menu, and click Fields. 
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4. Locate the Name attribute in the Attribute column, and click the associated 
Properties icon. 

5. Select the Open as Pop-up check box, and click Save and Return. 

6. Click Return. 
 

How to Work with Lists 

You can use CA Clarity PPM to work with lists of your project data. You can perform the 
following actions with lists: 

■ Filter the list to view only the information that you want 

■ Sort the list to see the items in a specific order 

■ Edit the lists to update and correct information 

■ Export lists to view and work with them in Excel. 
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The following diagram describes how a user can work with lists and filters: 

 
 

Follow these steps: 

1. List Options Toolbar (see page 42). 

2. Filter Lists (see page 43). 

3. Sort Lists (see page 45). 

4. Edit Lists (see page 46). 

5. Export Lists (see page 47). 
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List Options Toolbar 

The Options toolbar displays on the top of lists. The toolbar options help you manage 
the information included in lists. 

 

Filter 

Lets you filter the list with criteria you select. Double-click the toolbar or click the 
icons (+ or -) that appear next to the filter name to expand or collapse the filter. The 
filter in use is listed in the filter field. To see a list of saved filters, click the down 
arrow. For more information about filters, see Filter Lists (see page 43). 

Options Menu 

Lets you access options that apply to the portlet being viewed. The options that 
appear can vary depending on the portlet. The following list shows some of the 
options that appear on the Options menu. 

Configure 

You can configure the list in the following ways: 

■ Modify the list and filter fields. 

■ Modify the list and filter layout. 

■ Aggregate the information in columns. 

■ Set the options for how the list displays. 

■ Define the display settings for a Gantt chart. 

■ Define the time period settings for a time-scaled value. 

Note: For more information, refer to How to Configure a List. 
 

Multisort 

Allows you to sort the information in a list using multiple columns. For more 
information about sorting, see Sort Lists (see page 45). 

Export to Excel (Data Only) 

Exports the list to Microsoft Excel. No charts are included in this export. For 
more information about exporting, see Export Lists (see page 47). 

Note: Some lists display a Configuration icon in the Options toolbar. For these lists, you 
can set items that are selected from the list to display in a separate pop-up that floats 
above the workspace. The pop-up has the same functionality as a page presented in the 
workspace. 
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Filter the Lists 

Lists with many items can span multiple pages. Use the filter fields to filter the list to 
only those items you want to view. 

Use the Expand/Collapse Filter icon on the Options toolbar to hide or display the filter. 
When a list is filtered, you can return to the default results list and can view all the items 
in the list page. Click Show All or select System Default from the Filter drop-down. 

 

You can name a filter and can save the criteria for later use. Access saved filters from 
the Filter drop-down. 

Note: The filter fields are not case-sensitive. 
 

Follow these steps: 

1. Open the list page. 

2. Click the Expand Filter icon if the filter is not open. 

3. Enter the filtering criteria, and click Save Filter. 
 

4. Enter a name for the filter. 

5. Select Default to make this filter the default filter for this list page. 

6. Save your changes. 

Note: When you apply a filter to a hierarchical list, the expanded items collapse. The 
resulting filtered items include its parent and higher-level items. All rows display 
collapsed. 

 

Build a Power Filter 

A power filter is a custom filter that searches a list page by criteria you define. Use a 
power filter alone or with other filter fields on the list page. Only one power filter can be 
created for a list page. 

You design and build a power filter using an expression. The expression is divided into 
two parts, left and right, and separated by an operator, such as, =. For example, the 
expression to search for all active projects on the projects list page appears in the 
Expression text box as follows: 

project.is_active == 1. 
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Follow these steps: 

1. With a list page open, expand the filter. 

2. Click the Build Power Filter link in the filter section.  

3. Complete the following fields to build the left part of the expression: 

Note: The available fields depend on the page displayed. 

Object 

Specifies the type of object to filter. The page refreshes. 
 

Field 

Specifies the field to display in the Filter section. The page refreshes. 
 

4. Select one of the following operators: 

Note: The operators that are available depend on the object and field values that 
are used for the left part of the expression. 

■ = 

■ != 

■ > 

■ >= 

■ < 

■ <= 
 

5. Complete the following fields to build the right part of the expression: 

Note: The fields that are available depend on the page displayed. 

Constant 

Specifies the constant for the field. 

Values: Yes or No 

Example: Select the Active field of the project object and use the equals 
operator, then select Yes as the constant. This combination finds all active 
projects. 

 

Object 

Specifies the type of object to filter. The page refreshes. 
 

Field 

Specifies the field to display in the Filter section. The page refreshes. 
 

6. Click Add. 

The expression appears in the Expression field. 
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7. Select a value from the following field to create an equation with multiple clauses. 
For example, you can create a power filter with multiple clauses to display all active 
projects that are also assigned to a specific department. If you select a value from 
this field, create the additional clause for the expression and click Add. This action 
appends the clause to the value in the Expression field. 

And/Or 

Specifies the equation type for the second half of the expression. 

And 

Defines an equation with multiple clauses. 

Or 

Defines an either/or equation. 
 

8. Complete one of the following steps: 

■ Click Evaluate to evaluate the syntax of the expression. If the syntax is not valid, 
INVALID appears above the Expression text box. 

■ Click Add Parenthesis to surround the expression with parentheses. 

■ Click Negate Expression to negate the expression by surrounding the 
expression with parentheses and preceding it with an exclamation point. 

■ Click Clear to clear the Expression text box. 
 

9. Save your changes.  

The power filter is saved. The name appears in the Power Filter field of the page 
filter. 

 

Sort the Lists 

You can sort lists by row or column to view the items in the order you want. Once the 
list is sorted, you can reset the sort to the default sort order. You can sort parent items 
in lists. When the list is sorted, the child items inherit the sorting criteria of the parent. 

To sort a column, click the column header. When the list is sorted, an arrow appears in 
the column header. To reverse the sort order, click the column header again. Do the 
same to sort by any other column headers. 

 

 

Use the Multisort option to change the sort order of columns or sort by multiple 
columns to change your page layout. 

Follow these steps: 

1. Open a list page. 

2. Click the Options icon and select Multisort. 
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3. Complete the following field: 

First Field 

Specifies the column that leads the sort order. 

Type: Text 

Displays information in alphabetical order. 

Type: Numbers 

Displays information in numerical order. 
 

 

 

 

4. Complete the information for the second, third, and fourth fields. 

5. Indicate the direction of the sort for each selection you make in a Column field 
(ascending or descending) and click Save. 

 

Edit the Lists 

When you click in a field to update, the entire list is placed into edit mode. Use the edit 
feature to update and correct fields in a list. You can click links and icons in other fields 
while the list is in the edit mode. A flag appears in the field to indicate an unsaved 
update. Press the Esc key to return to the display mode and discard the unsaved 
changes. 

Note: If the field can be edited, the field changes to edit mode. If no action occurs, the 
field cannot be edited. 

 

In addition to editing lists, you can insert an item. 

Note: If the list includes a time-scaled value column and you want to edit the 
time-scaled information, save your changes first. 

 

Follow these steps: 

1. Open a list page. 

2. Select the check box or click anywhere on the item row to insert a new row below 
it. 

3. Click New. 
 

4. Edit the fields and save your changes. 

The new row is inserted with the updated fields. 

Note: Fields that are displayed are required. 
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Export the Lists 

You can export the information from any list portlet that displays the Export to Excel 
(Data Only) icon in the Options toolbar. Exporting to Excel is especially helpful when the 
list extends over multiple pages. To use statistical operations such as SUM and 
AVERAGE, export and view the list in the Excel format. 

Note: If the Export to Excel icon is not displayed, the list is restricted. 
 

The following rules apply when you export information in a list: 

■ You can run only one active export at a time. 

■ If you apply filter criteria, only the filtered results are exported. 
 

■ Only first-level items are exported. 

■ Only the fields that are displayed in the list are exported. 

■ Only the items that are listed on the page are exported. If you have more than one 
page, export these pages independently. 

 

■ For items that contain charts (including Gantt charts), you can export a maximum of 
300 items. 

■ You can export an unlimited number of items without charts. Use the Export to 
Excel (Data Only) option, and leave the Maximum rows for the Export to Excel field 
empty. 

 

■ The exported information appears in Excel or PowerPoint the way that information 
appears in CA Clarity PPM. 

■ You can export some CA Clarity PPM pages that contain portlets, like the Overview 
page. If you can export a page of portlets, the export option is available. 

Important! Expect certain changes in how information is displayed in Excel when you 
export CA Clarity PPM information to Microsoft Excel. 

 

Before you export information, verify that you are exporting the returned results and 
have not applied any pagination. 

Follow these steps: 

1. Open the list page that contains the information you want to export and click the 
Export to Excel icon.  

 

2. Open the list as an Excel spreadsheet, or save it to your local desktop. 
 



How to Work with Lists 

 

48  Basics User Guide 
 

How Information Transfers from CA Clarity PPM to Excel 

When you export CA Clarity PPM information to Microsoft Excel, the format settings for 
each column are exported to Microsoft Excel. The formulas that are used for 
aggregating or comparing column values are exported. You can expect certain changes 
in how information is displayed in Excel. 

The following list describes how the various values appear in the Excel spreadsheet: 

String 

String 
 

URL 

Hyperlinked string 
 

Grid columns with links 

If the link is an image, then the column information in Excel is the image description 
(alternate text). 

 

Boolean image or value 

Yes/No 
 

Number or formula or virtual icon column (such as image, stoplight, value, or range 
description) 

Up to three columns: one for value (number), one for range description, and one 
narrow column with background color if stoplights are displayed. Formulas export 
actual values, not the formulas themselves. 

 

Date 

Date formatting is preserved. 
 

Money 

Two columns: numeric value and currency code. The correct number of decimal 
places is preserved. 

 

Virtual Gantt primary bar data 

Three columns: Item name, start date, and end date, in addition to a Gantt chart 
column header prefix to show they all belong together. 

 

Virtual Gantt secondary bar data 

Three columns: Item name, start date, and end date, in addition to a Gantt column 
header prefix to show that the columns belong together. The header prefix also 
shows that the columns are different from the primary bar. 

 

Virtual progress bar 

Three columns: Current stage name, current stage number, and number of stages, 
in addition to a Progress column header prefix to show that the columns belong 
together. 
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Column header 

If present in CA Clarity PPM, this value appears. 
 

Secondary value 

Appears in a separate column; the column header title uses the attribute name. 
 

Time-scaled values 

One column for each time slice (years, months, quarters, weeks, or days). In 
addition, a Gantt column header prefix shows that the time slices belong together. 

 

Aggregation, comparison, and variance rows 

The values or results are displayed in rows. The values are gray and do not display a 
corresponding row header. Select an aggregation or comparison value to see the 
formula for calculating the value in the Excel formula bar. 

 

Highlighted row by attribute 

The two highlighted rows in Excel do not appear highlighted in Excel. 
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Chapter 6: How to Configure a List 
 

This section contains the following topics: 

Set List Column Layout (see page 51) 
Set List Options (see page 51) 
Add a Gantt Chart to a List Portlet (see page 52) 
Add an Image to a List Portlet (see page 55) 
Add a Progress Bar to a List Portlet (see page 56) 
Add a Time Scaled Value to a List Portlet (see page 57) 
Add an Aggregation Row for a Number Field to a List Portlet (see page 60) 
Display an Aggregation Field as a Bar or Column Graph (see page 60) 

 

Set List Column Layout 

You can set the list column layout. 

Follow these steps: 

1. Click the Options icon that appears on the portlet toolbar. 

2. Open the Options menu, and click Configure. 
 

3. Select the columns in the Available Columns list and click the arrow to add them to 
the Selected Columns list in the Column Layout section.  

You can use the Move Up and Move Down arrows to place the selected columns in 
the desired order.  

 

4. Complete the following actions in the Column Sorting section: 

a. Select the appropriate field in the Column drop-down list to select the order in 
which you want to sort the columns. 

b. Click Ascending or Descending to sort data within each column. 

Note: Column sorting is not available for hierarchical list pages. 

5. Save your changes. 
 

Set List Options 

You can set list options that let you modify the display and appearance of list items. 

Follow these steps: 

1. Open the Options menu that appears on the portlet toolbar, and click Configure. 
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2. Open the List Column Section menu, and click Options. 

3. Complete the requested information. The following fields require explanation: 

Secondary Value Display 

Indicates how the secondary values display in a grid cell.  

Values:  

■ Mouseover only. Specifies no secondary value display.  
 

■ Mouseover and redline text. Specifies the display of a secondary, 
comparison value when you place the cursor over a cell in a grid. For 
example, if you have two columns named Cost and Baseline Cost, you can 
display both values in a cell. To display both, select Baseline Cost as the 
secondary value. The Cost value displays as usual. However, when you 
move the cursor over a cell in the grid, the Baseline Cost also displays. 

 

■ Show Null Secondary Values. Specifies that the secondary value displays 
even when there is no number value to show. 

 

 

Filter 

Indicates how the results appear initially on a page. 
 
 

Display Currency Code in Column 

Specifies whether to display the currency code in the column for money 
attributes.  

 

Allow Configuration 

Indicates that users can modify the appearance of a portlet. 
 

Allow Label Configuration 

Indicates that users can modify portlet labels. 

4. Save your changes. 
 

Add a Gantt Chart to a List Portlet 

A Gantt chart is a virtual field that shows the duration and progress over time. New 
virtual fields are automatically displayed in the far right column of the list. You can move 
the field to a different position in the List Column layout. 

Follow these steps: 

1. Open the Options menu that appears on the portlet toolbar, and click Configure. 

2. Open the List Column Section menu, and click Fields. 
 

3. Click New. 
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4. Select Gantt, and click Next. 

5. Complete the requested information in the General section. 
 

6. Complete the requested information in the Time Scale section. The following fields 
require explanation: 

Time Scale 

Specifies the time values to show across the top of the Gantt chart. 

Number of Time Periods 

Defines the number of time periods that display. 
 

 

Time Period Offset 

Defines the number of time periods that you want to shift the beginning of the 
Gantt bar relative to the Start Date. Enter a Start Date value to use this option. 

 

Show Group Row Header 

Indicates whether to print the time scale value used. Select the check box to 
show the value and select the value to be shown from the drop-down list. 

 

7. Complete the requested information in the Primary Bar section. The following fields 
require explanation: 

Item Name Attribute 

Specifies the field name for the primary bar of the Gantt chart. 
 

Start Date Attribute 

Specifies the date field value to use at the beginning of the Gantt bar. 
 

Finish Date Attribute 

Specifies the date field value to use at the end of the Gantt bar. 
 

Milestone Attribute 

Specifies the field value to use as a milestone. Select a field from the 
drop-down list. If the field contains a non-zero value, the Gantt chart displays a 
diamond. 

 

Progress Through Date Attribute 

Specifies the date field value to use to indicate when work is complete. If you 
select a value, the selected value overrides the Progress Percent Attribute. 

Progress Percent Attribute 

Defines the percentage that is used to move the green progress line relative to 
the length of the taskbar to indicate the completed work. If you select a value 
for this field, it overrides the Progress Through Date Attribute selection. 

 

Label for Bar 

Specifies the label text to display above each taskbar. 
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Additional Information Attribute 

Specifies the field that is used in the text note when you hover over a taskbar. 
For example, to display the assigned resources for a task, when the cursor is 
over a taskbar, complete the following steps: 

■ Select Assigned Resources from the Additional Information Attribute field.  

■ Select Additional Information in the Show Mouseover field. 
 

Show Mouseover 

Indicates the values that appear when a user moves a cursor over the bar. 
Select the check boxes of the items listed that you want to appear. 

 

8. Select the dates that you want to show on the primary Gantt bar from the Available 
list in the Show Dates on Primary Bar section. Click the arrow to move the dates to 
the Selected list. 

9. (Optional) Select the Show Secondary Bar check box and complete the fields in the 
section to display a second bar below the primary bar for comparison purposes. 

 

10. Save your changes. 
 

Configure the Gantt Chart Display Settings 

Gantt charts appear on various pages throughout CA Clarity PPM. The steps to change 
the display settings are the same from any page with a Gantt chart. 

 

By default, Gantt charts display only one bar, the primary bar. You can change the 
information that is displayed in that bar (Total Effort, by default). You can also add a 
secondary bar to display complementary or contrasting data. You can also change the 
time configurations that display in the chart. 

 

Follow these steps: 

1. Open the Options menu and click Configure on a page that contains a Gantt chart. 
 

2. Open the List Column Section menu, and click Fields.  
 

3. Click the Properties icon next to Column Label (for example, Schedule). 
 

4. Configure the Gantt chart display settings. 
 

5. Save your changes. 
 

Modify Time Period Settings for a Gantt Chart 

You can change the Gantt chart timescale to zoom in and out of the timeline. For 
example, if you are viewing the monthly timeline, to zoom in to see daily timeline 
information, select the Days timescale value from the Calendar drop-down at the top of 
the Gantt chart. 
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Follow these steps: 

1. Open the Options menu and click Gantt on a page that contains a Gantt chart. 
 

2. Modify the following fields: 

Start Date 

Indicates the start date for the column spread. 
 

Time Scale 

Specifies the time period by which data displays (for example, days or weeks). 
 

Number of Time Periods 

Defines the number of time periods that display. 
 

Time Period Offset 

Defines how to shift the beginning of the Gantt bar relative to the start date. 
Enter a positive or negative number of time periods into the field.  

 

3. Save your changes. 
 

View and Edit List Portlet Fields 

You can view and edit the fields that display in a list portlet. You can identify specific 
columns to display, and you can change the label and other properties of fields. 

 

Follow these steps: 

1. Open the Options menu and click Gantt on a page that contains a Gantt chart. 

2. Open the List Column Section menu, and click Fields. 
 

3. Use the Show and Display fields and select columns or a combination of both to 
control what you see in the list. Select the correct option and click Go. 

 

4. Click the Properties icon to change the way that a field displays. 
 

5. Enter a new value in the Column Label field to change a field label. 

6. Save your changes. 
 

Add an Image to a List Portlet 

You can add an image that links to another page. New virtual attributes like an image 
are automatically displayed in the far right column of the list. You can move the virtual 
attribute to a different position in the List Column layout. 
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Follow these steps: 

1. Open the Options menu that appears on the portlet toolbar, and click Configure. 

2. Open the List Column Section menu, and click Fields. 
 

3. Click New. 
 

4. Select Image, and click Next. 
 

5. Complete the requested information in the General section. The following fields 
require explanation: 

Image 

Specifies the image to use in the grid column.  
 

Link 

Specifies a page link that appears as a secondary value that the user can select. 
 

Open as Pop-up 

Indicates whether the target page of the image link appears as a pop-up. 
 

6. Save your changes. 
 

Add a Progress Bar to a List Portlet 

A progress bar shows progress over time. New virtual attributes like the progress bar 
are automatically displayed in the far right column of the list. You can move the virtual 
attribute to a different position in the List Column layout. 

 

Follow these steps: 

1. Click the Options icon that appears on the portlet toolbar. 

2. Open the Options menu, and click Configure. 

3. Open the List Column Section menu, and click Fields. 
 

4. Click New. 
 

5. Select Progress Bar, and click Next. 
 

6. Complete the requested information. The following fields require explanation: 
 

 

Current Stage Name 

Specifies the field value to use for each stage in the progress bar. The value 
displays below the column label. 

 

Current Stage Number 

Specifies the field value to use for the current stage in the progress bar. 
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Number of Stages 

Specifies the field value that defines the total number of stages in the progress 
bar. 

 

 

Show Label 

Indicates whether the name of the current stage is displayed in the progress 
bar.  

 

 

7. Save your changes. 
 

Add a Time Scaled Value to a List Portlet 

You can set up a time-scaled value on a list portlet to show a value for a specific period. 
This value is based on a time-varying attribute for which a user enters values in CA 
Clarity PPM. As a user you cannot create a time-varying attribute. Only an administrator 
with the appropriate rights can create a time-varying attribute. 

 

You can display multiple time-scaled values in a list portlet. The data for these attributes 
displays as stacked on the page, with the information for each time-scaled value 
appearing in the same virtual column. The data that displays can be in units of money, 
numbers, or percentages.  

 

New virtual attributes, such as a time-scaled value, are automatically displayed in the far 
right column of the list. You can move the virtual attribute to a different position in the 
List Column layout. 

 

Follow these steps: 

1. Click the Options icon that appears on the portlet toolbar. 

2. Open the Options menu, and click Configure. 

3. Open the List Column Section menu, and click Fields. 
 

4. Click New. 
 

5. Select Time Scaled Value, and click Next. 
 

6. Complete the requested information in the General section. The following fields 
require explanation: 

Value Attributes 

Indicates the time scaled values that display in the virtual column. Select the 
attributes in the Available list and use the arrows to move the attributes to the 
Selected list. 

 
 

 

Secondary Value 

Specifies a second value for a time-scaled value virtual column that displays as 
a tooltip when you mouse over the value in the column. 
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Link 

Specifies a page link that appears as a secondary value that the user can select. 
 

Open as Pop-up 

Indicates whether the target page of the image link appears as a pop-up. 
 

Show Legend Label 

Indicates whether the field label appears next to the time-scaled value in the 
virtual column. Select the check box to display the field label. 

 

Show Column Label 

Indicates whether the column label appears at the top of the column list.  
 

7. Complete the requested information in the Time Scale section. The following fields 
require explanation: 

Start Date 

Indicates the start date for the time period for the virtual-scaled value. 

Note: The Other Date option appears only if you select a start date for a 
time-scaled value for a subobject. This field lets you select a field from the 
master object on which to base the start date. This option only appears when a 
subobject has time-scaled value attributes. 

 

Time Scale 

Specifies the length of time the time-scaled value covers. 

Values: 

■ Specific Time Scale. Specifies the period (length of time) for the 
time-scaled value. 

■ Other Time Scale. This option appears only if you select a time scale for a 
time-scaled value. Select a field from the master object on which to base 
the time scale. 

 

Number of Time Periods 

Defines the number of time periods to be reported in the virtual column. 
 

Time Period Offset 

Defines the number of time periods that you want to shift the beginning of the 
time-scaled value relative to the Start Date. Enter a Start Date value to use this 
option. 

 

Show Group Row Header 

Specifies a timescale to be displayed above the virtual column. Select the check 
box to display a timescale and select the period type. 
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8. Complete the following fields in the Display section. The following term requires 
explanation: 

Decimal Places 

Defines the number of decimal places to return for the attribute. To specify the 
attribute as an integer, enter a zero (0). 

9. Save your changes. 
 

Edit a Time Scaled Value 

You can edit a time scaled value using the Options menu on the portlet toolbar: 

Configure 

When you edit a time scaled value using this option, the setting applies to all the 
sessions only for that user, subject to any partitioning of the object views. 

Follow these steps: 

1. Open Home, and from Resource Management, click Resources. 

2. Click the name of a resource. 

3. Click Allocations, Detail. 

4. Open the Options menu that appears on the portlet toolbar, and click Configure. 

5. Open the List Column Section menu, and click Fields. 

6. Click the Properties icon of the Time Scaled Value and edit the values. 

7. Save the changes. 
 

Time-scaled Value 

When you edit a time scaled value using this option, the setting applies to that user and 
only for that session, subject to any partitioning of the object views. This setting 
supersedes the values set using the previous method. 

Follow these steps: 

1. Open Home, and from Resource Management, click Resources. 

2. Click the name of a resource. 

3. Click Allocations, Detail. 

4. Open the Options menu that appears on the portlet toolbar, and click Time-scaled 
Value. 

5. Edit the values and save the changes. 
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Add an Aggregation Row for a Number Field to a List Portlet 

An aggregation row shows statistical data for money or number fields that display in the 
aggregation row. You can select from a number of mathematical functions to apply to 
the individual fields you select for the row. You can select maximum, minimum, average, 
sum, count, standard deviation, and variance. 

 

Follow these steps: 

1. Click the Options icon that appears on the portlet toolbar. 

2. Open the Options menu, and click Configure. 

3. Open the List Column Section menu, and click Aggregation. 
 

4. Click Add. 
 

5. Complete the requested information: 

Label 

Defines the name for the aggregation row. 
 

Show 

Determines whether the name of the aggregation row is displayed.  
 

Attribute 

Specifies the field value that is used for the aggregation. All fields that you have 
selected for the grid portlet are present for selection but do not have to be 
included in the aggregation row. 

 

Function 

Specifies the aggregation function that is used to calculate values for a selected 
field (cell) in the row.  

 

6. Save your changes. 
 

Display an Aggregation Field as a Bar or Column Graph 

You can display a field in an aggregation row as a number, bar graph, or a column graph. 
By default, the field displays as a number when it is first added to the aggregation row. 
The following procedure describes how to display an aggregation field as a bar or 
column graph. 
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This procedure assumes that the aggregation row with number fields has been created. 

Follow these steps: 

1. Click the Options icon that appears on the portlet toolbar. 

2. Open the Options menu, and click Configure. 

3. Open the List Column Section menu, and click Aggregation. 

4. Click the word in the Display row that appears below the column that you want to 
change. 

 

5. Select the display type, and click Save and Return. 

If you select bar or column graph, these words appear at the bottom of the column 
in the Display row. 

6. Click Bar Graph or Column Graph in the Display Row to complete the additional 
fields for the setup for a bar or column graph. 

7. Complete the requested information in the Primary Column section. The following 
fields require explanation: 

 

Maximum Length 

Defines the maximum length for a column or bar graph in pixels. 
 

Length Scaling 

Specifies the basis for scaling if the graph is scaled.  
 
 

Threshold Line Attribute 

Specifies the field that is used to calculate a threshold for the graph. 
 

Threshold Aggregation Function 

Specifies the mathematical function that is used to calculate a threshold for the 
graph. 

 

Over-threshold Color 

Specifies the graph color that indicates when the threshold has been exceeded. 
 

8. Complete the requested information in the Stacked Column section to stack a 
second aggregation field value in the column of the list portlet. 

Stacked Attribute 

Specifies the second field value to be displayed as a bar or column graph in a 
column. 

 

 

9. Save your changes. 
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Chapter 7: How to Configure a Chart Portlet 
 

This section contains the following topics: 

Uses of Charts (see page 63) 
Determine a Chart Portlet Appearance (see page 64) 
Determine a Chart Portlet Source Data (see page 68) 
Configure for Consistent Chart Colors (see page 69) 
Apply or Remove Consistent Chart Colors (see page 69) 

 

Uses of Charts 

You can use the three-dimensional and animation charting capabilities to organize and 
visually represent complex information. You can use charts to: 

■ Mouse over data points to view additional information about dimension values and 
metrics. 

■ Drill down to view details about a data point on a chart. 

■ Slice a pie or a funnel chart to call out information. 

■ Assign colors and change X and Y-axis labels. 
 

You can display charts from any portlet page, such as the Overview page or dashboards. 
You can add charts by personalizing pages or your CA Clarity PPM administrator can add 
charts using Studio. 

For more information, see the Studio Developer documentation. 

You can print, slice, or can rotate charts by setting chart options. 

Right-click a chart to set the following chart options: 

■ Print. Prints the chart. 

■ Slicing. Extracts slices from a pie or a funnel chart. Slicing is the default setting. 

■ View 2-D. Temporarily changes to a two-dimensional view of the chart. When you 
leave the chart portlet page and return, the chart view is three-dimensional. 

 

The following table describes the available options for each chart. 

 

Chart Type View 2-D Slicing Rotation 

Area Yes No No 

Bar No No No 
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Bubble No No No 

Column Yes No No 

Funnel Yes Yes No 

Line Yes No No 

Pie Yes Yes Yes 

Scatter Yes No No 
 

Determine a Chart Portlet Appearance 

You can determine the appearance of any chart. This procedure assumes that the basic 
chart has been created and the chart data has been selected. 

 

Follow these steps: 

1. Open Administration, and from Studio, click Portlets. 

2. Select the Type as Filter/Graph to search for the portlet. 

3. Open the filter portlet, and from the Chart Section menu, click Options. 
 

4. Select the part of the chart for which you want to set options.  
 

5. Complete the requested information depending on the type of chart you select. The 
following fields require explanation: 

Allow Configuration 

Indicates that users can modify the appearance of a portlet. 
 

Allow Label Configuration 

Indicates that users can modify portlet labels. 
 

Angle of First Slice 

Defines the position of the first dividing line. Use with Pie and Funnel charts. 

Values: 0 to 360 degrees 

Default: 0 
 

Axis Label 

Displays the metric name along the X-axis, Y-axis, or both axes. Use this option 
with: 

■ Bar. X-axis, Y-axis. 

■ Column. X-axis, Y-axis. 

■ Line. X-axis, Y-axis. 

■ Bubble and Scatter. X-axis. 
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Crosses Opposite Axis At 

Defines the intersection point of the axis. Use with bubble and scatter charts. 
 

Category Labels 

Specifies the labels that appear along the category axis for the X-axis of column 
and line graphs and the Y-axis of bar graphs. For example, consider a column 
graph that shows five months of data with three metrics (shown as red, green, 
and blue bars). The months are the categories, and this field determines the 
label that appears on each one. 

 

Datapoint Labels 

Specifies the data name that appears next to the value on the chart. Use this 
option with all data types. 

 

Decimal Places 

Defines the number of decimal places to display for numbers. Use this option 
with: 

■ Bar. X-axis. 

■ Column. Y-axis. 

■ Line. Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Display Units 

Specifies how values are rounded up. Select a value for rounding from the 
drop-down list. Use this option with: 

■ Bar. X-axis. 

■ Column. Y-axis. 

■ Line. Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Filter 

Indicates how the results appear initially on a page. 
 

Link 

Specifies a page link that appears as a secondary value that the user can select. 
 

Major Unit Increment 

Defines the interval of major ticks on the axis. Use this option with: 

■ Bar. X-axis. 

■ Column. Y-axis. 

■ Line. Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
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Maximum Value 

Defines the greatest value to display on the axis. Use this option with: 

■ Bar. X-axis. 

■ Column. Y-axis. 

■ Line. Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Mouseover Labels 

Specifies the data values to show when a user moves the cursor over a chart 
value. Use with all chart types.  

 

Other Category Threshold 

Defines the data point at which all records for a specified value are grouped 
into a category named Other. Use this option if too many items appear on the 
chart. Use this option with the following chart types: 

■ Bar 

■ Column 

■ Line 

■ Pie and Funnel 
 

Show Axis 

Indicates whether the Axis line displays. Use this option with: 

■ Bar. X-axis, Y-axis. 

■ Column. X-axis, Y-axis. 

■ Line. X-axis, Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Show Legend 

Specifies whether to display a legend for the chart. Use with bar, column, line, 
bubble, and scatter chart types. 

Default: Selected 
 

Show Line Markers 

Indicates data points on the chart; otherwise, only a line displays. Available for 
line charts. Select the check box to show line markers. 

 

Show Lines 

Indicates that lines are to connect the data points. Available for line charts. 
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Show Major Grid Lines 

Indicates whether major grid lines display on the chart. Use this option with: 

■ Bar. X-axis, Y-axis. 

■ Column. X-axis, Y-axis. 

■ Line. X-axis, Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Show Separator 

Specifies that a comma separates values greater than 999 (for example, 1,000). 
Use this option with: 

■ Bar. X-axis. 

■ Column. Y-axis. 

■ Line. Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Show Tick Labels 

Indicates whether tick labels display on the chart. Use this option with: 

■ Bar. X-axis, Y-axis. 

■ Column. X-axis, Y-axis. 

■ Line. X-axis, Y-axis. 

■ Bubble and Scatter. X-axis, Y-axis. 
 

Show Title 

Indicates that the portlet name displays. Available for all chart types. 
 

Sort Column 

Indicates that a column is the default sort item. This option is available for 
column and line charts. 

 

Sub-type 

Indicates the metrics that display as separate bars rather than a single merged 
bar. Select the sub-type that is desired. This option is available for bar and 
column charts. 

 

Tick Label Angle 

Sets the angle of a label that is used with tick marks. Use this option with: 

■ Bar. X-axis. 

■ Column. X-axis. 

■ Line. X-axis. 

■ Bubble and Scatter. X-axis. 
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6. (Optional) Select Guides in the Options field and click New to configure a line chart. 
Complete the following fields and save your changes: 

Axis 

Specifies the axis for which guides are being set. 
 

Label 

Defines the name for the axis.  
 

Show Label 

Determines whether the name of the axis displays. 
 

Type 

Identifies the source of the information that displays on the guide. Select the 
appropriate option. If you are selecting a type for an X-axis, you can only select 
an attribute. If you are selecting a type for a Y-axis, select either the fixed value 
or the percent value and enter the amount. 

Default: Attribute 
 

Color 

Specifies the color for the guide. 

Default: Black 
 

Determine a Chart Portlet Source Data 

You can determine which data displays on a chart.  

Follow these steps: 

1. Open Administration, and from Studio, click Portlets. 

2. Select the Type as Filter to search for the portlet. 

3. Open the filter portlet, and from the Chart Section menu, click Source Data. 
 

4. Select the metrics that you want to include in the chart. 

5. Save your changes. 
 



Configure for Consistent Chart Colors 

 

Chapter 7: How to Configure a Chart Portlet  69  
 

Configure for Consistent Chart Colors 

If your administrator selects the Use Consistent Chart Colors option at the system level, 
you can configure a chart portlet to: 

■ Use consistent colors 

■ Use a consistent color key when assigning colors to a chart portlet. If you select a 
key, the color palette (out-of-the-box or custom) assigns colors that are based on 
the key. 

 

Follow these steps: 

1. Open a page that contains the chart that you want to modify. 
 

2. Open the Options menu and click Configure. 
 

3. Complete the requested information. The following fields require explanation: 

Consistent Color Key 

Specifies the consistent color key. The list of available keys depends on the 
source data of the specific chart. 

 

Use Consistent Colors Select 

Specifies overriding the selection (for this chart only) at the system level. 

Values: Yes or No 
 

4. Save your changes. 
 

Apply or Remove Consistent Chart Colors 

The administrator can enable the Use Consistent Chart Colors option at the system 
level. You can switch between applying and not applying consistent colors at the chart 
level. The ability gives you flexibility when the colors assigned to the chart make it 
unreadable (for example, more than one data set displays the same color). Toggling 
between states of color is useful when charts with multiple metrics are used and the 
legend displays only one color. 

 

If consistent colors are currently applied to a chart, you can switch to the Default Colors 
(inconsistent colors) option. Conversely, if you do not apply consistent colors to a chart, 
you can switch to the Consistent Colors option in the Options menu. 

 

The changes that you make at a chart portlet level during a CA Clarity PPM session are 
only available in that session. Once you log out, the changes are lost. For the changes to 
be available outside a session, configure the chart portlet. 

 

Follow these steps: 

1. Open a page containing the chart that you want to modify. 
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2. Select Consistent Colors or Default Colors from the Options toolbar for the chart 
portlet.  

The option that is available depends on the current chart setting (Default or 
Consistent). 
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Chapter 8: How to Configure a Filter Portlet 
 

This section contains the following topics: 

Filter Portlets (see page 71) 
Add a Field to a Filter Portlet (see page 71) 
Add a Lookup or Multi-Valued Lookup Field to a Filter Portlet (see page 72) 
Lay Out Fields on a Filter Portlet (see page 74) 

 

Filter Portlets 

A filter portlet coordinates the filtering of data in portlets. You can configure a filter 
portlet to share filter values at the following levels: 

Page Level  

Filter values are not shared across pages. 

Application Level  

Filter values are shared across pages. To implement an application-level filter, add 
the same filter portlet to each page. 

 

Add a Field to a Filter Portlet 

You can add a field to a filter portlet. 

Follow these steps: 

1. Open Administration, and from Studio, click Portlets. 

2. Select the Type as Filter and search for the portlet. 

3. Open the filter portlet, and click Fields. 

4. Click Add.  
 

5. Complete the requested information. The fields can vary depending on the Data 
Type you select. Not all listed fields appear for each data type. 

 
 

 

Data Type 

Specifies the data type for the field. Once you save, you cannot change the data 
type. 

 

 

Show as Percent 

Indicates if the value entered in the field displays as a percent.  
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Filter Default 

Specifies the value that appears as the default value in the filter field. If the 
filter portlet associated with this field is published to a dashboard as the filter 
default, this value is applied to the portlet attributes that are mapped to this 
field. 

 

Width 

Defines the width of the field. If you leave the field blank, the field receives the 
default, which is 30 pixels. The default for date fields is 20 pixels. 

F 

Required in Filter 

Specifies that a value is required in the field when a filter request is executed. If 
you select this check box, enter a value in the Filter Default field. 

 

Hidden in Filter 

Specifies that the field does not display in the filter at runtime, but the default 
value of the field is included when you execute a filter request. Select the check 
box to hide the field in the filter.  

 

Read-Only in Filter 

Specifies that the field displays with a default value that you cannot edit. Select 
the check box to make the field read-only in the filter. 

 

Hint 

Defines a short message that helps a user use the field. 

Limits: 512 characters 
 

 

6. Save your changes. 
 

Add a Lookup or Multi-Valued Lookup Field to a Filter Portlet 

You can add a lookup or multi-valued lookup field to a filter portlet. Lookup fields 
display a drop-down or a browse list from which users can select items. 

Follow these steps: 

1. Open Administration, and from Studio, click Portlets. 

2. Select the Type as Filter and search for the portlet. 

3. Open the filter portlet, and click Fields. 
 

 

4. Click Add.  
 

5. Complete the requested information. The following fields require explanation: 
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Data Type 

Specifies the data type for the field. When you select Lookup or Multi Value 
Lookup, the fields on the page change to reflect the lookup you select and its 
data source (static or dynamic). 

 

Display Type 

Specifies how the field is used (Text Entry or Exact Text). 
 

Lookup 

Specifies a list of lookup values that appears in the field for the user to select. 
The user views the list according to the display type selected. 

 

Some of the fields that are listed in this section may not show on your page. 

Lookup Style 

Indicates how many items a user can select for the field when the lookup is 
executed. 

 

Entry 

(Static dependent lookup lists only). Defines the starting point for the data a 
user sees listed in the lookup field. Select a level in the Level field or select a 
parent lookup value. 

 

Exit 

(Static dependent lookup lists only). Defines the end point of the data a user 
sees listed in the lookup field. 

 

Filter Default 

Specifies the value that appears as the default value in the filter field. If the 
filter portlet associated with this field is published to a dashboard as the filter 
default, this value is applied to the portlet attributes that are mapped to this 
field. 

 

Required in Filter 

Specifies that a value is required in the field when a filter request is executed. If 
you select this check box, enter a value in the Filter Default field. 

 

Hidden in Filter 

Specifies that the field does not display in the filter at runtime, but the default 
value of the field is included when you execute a filter request. Select the check 
box to hide the field in the filter.  

 

Read-Only in Filter 

Specifies that the field displays with a default value that you cannot edit. Select 
the check box to make the field read-only in the filter. 
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Hint 

Defines a short message that helps a user use the field. 

Limits: 512 characters 
 

 

6. If you selected a parameterized lookup in the Lookup field, complete the mappings 
in the Lookup Parameter Mappings section. This section is visible only for 
parameterized lookups. 

7. Save your changes. 
 

Lay Out Fields on a Filter Portlet 

You can determine the placement of the fields within the filter portlet when it is 
rendered on a portlet page. Use this procedure after you have created the filter portlet 
and its fields. 

 

The displayed list order of fields is how the fields appear in the Section view on a portlet 
page. If the Toolbar view is selected for the filter portlet, the fields display in a different 
order. The left column is equivalent to the top row and the right column is equivalent to 
the bottom row on the portlet. The left and right columns represent where the fields 
display on the portlet page. 

Follow these steps: 

1. Open Administration, and from Studio, click Portlets. 

2. Select the Type as Filter and search for the portlet. 

3. Open the filter portlet, and click Layout. 
 

4. Move the fields to the appropriate list box (Left Column or Right Column) using the 
arrows in the Layout section. The order of the fields in the list boxes is the order of 
appearance in the filter portlet. 

To reorder the fields, highlight the field and click the up and down arrows. 
 

5. Complete the requested information in the Settings section. The following fields 
require explanation: 

Render As 

Indicates how you want the filter portlet to appear on the published page or 
dashboard. Select Toolbar or Section. If you select Toolbar, the default filter 
state is fixed as Expanded. 

 

Default Filter State 

Indicates whether the filter portlet displays on the dashboard as expanded or 
collapsed. 

6. Save your changes. 
 



 

Chapter 9: How to Create and Manage Discussions  75  
 

Chapter 9: How to Create and Manage 
Discussions 
 

This section contains the following topics: 

Uses of Discussions (see page 75) 
Create a Discussion Topic (see page 75) 
Post a Message or a Reply (see page 76) 

 

Uses of Discussions 

Use discussions to exchange ideas and communicate in a common location on subjects 
relevant to the participating resources. You can post discussion topics and reply to 
topics and messages. Users with the appropriate access rights can access discussions 
from within certain objects. You can use discussions from the following locations: 

■ Projects and Programs 

■ Requisitions 
 

Create a Discussion Topic 

Only a collaboration manager can create new discussion topics. By default, the user who 
creates projects or programs is the collaboration manager. You can designate additional 
collaboration managers. 

An author cannot change the topic or message content once it is posted. Only a 
collaboration manager for the project or program can delete discussion topics and 
messages.  

 

Follow these steps: 

1. Open Home, and from Portfolio Management, click Programs or Projects. 

2. Click the name of the program or project. 
 

3. Click Collaboration, open the Collaboration menu, and click Discussions. 

4. Click New.  

5. Complete the requested information, and click Submit. 
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Post a Message or a Reply 

You can post a message to a discussion topic, and you can post a reply to a message. 

Follow these steps: 

1. Open Home, and from Portfolio Management, click Programs or Projects. 

2. Click the name of the program or project. 
 

3. Click Collaboration, open the Collaboration menu, and click Discussions. 

4. Click the name of the topic or message to which you want to respond. 
 

5. Click New. 

6. Complete the requested information, and click Submit.  
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Chapter 10: How to Work with Folders and 
Documents 
 

This section contains the following topics: 

Knowledge Store and Document Manager (see page 77) 
Knowledge Store Access Rights (see page 78) 
Knowledge Store and Document Manager Permissions at the Folder and Document 
Levels (see page 78) 
How to Create a Folder (see page 79) 
How to Manage a Folder (see page 80) 
How to Manage Documents (see page 82) 

 

Knowledge Store and Document Manager 

You can access and manage your documents from two repositories: 

■ The Knowledge Store 

■ Document Manager 

Your administrator maintains the Knowledge Store and Document Manager. These 
repositories contain documents on policies or procedures. 

You can use the Knowledge Store to save and access your generic documents. You can 
use Document Manager to build a repository for project or program-related forms and 
documents. You can also attach documents, such as a resume or an application form, to 
a resource profile. 

 

Though most users can access these repositories, their access to the folders and 
documents within it vary. With the appropriate permissions, users can create folders, 
add documents to them, and edit both documents and folders. The key differences exist 
in the access rights of the two repositories. 

To open the folders to which you have access, open Home, and from Organization, click 
Knowledge Store. 

Note: If you do not see the Knowledge Store link, contact your CA Clarity PPM 
administrator. 
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Knowledge Store Access Rights 

Access to the Knowledge Store and its folders and documents is provided at the 
following levels: 

■ Access rights at the Knowledge Store level 

■ Permissions at the folder and document levels 

The following access rights are available to manage or view content in the Knowledge 
Store: 

 

Access Right Description 

Knowledge Store - 
Administrate 

■ Allows you to access all of the folders and 
documents.  

■ Only users with the Knowledge Store - Administrate 
right can create folders at the top level of the 
Knowledge Store folder tree. 

■ Users with the Knowledge Store - Access right and 
with the appropriate permissions can add sub folders 
and documents to the folders. 

Knowledge Store - Access ■ Allows you to create, edit, and view documents and 
folders to which you have access.  

■ Allows you to delete the folders you created, and the 
documents you added. 

Knowledge Store - View All ■ Allows you to view all documents. 
 

Knowledge Store and Document Manager Permissions at the 
Folder and Document Levels 

The CA Clarity PPM administrator grants the Knowledge Store access rights. When you 
create or administer a folder or document, identify the users who need access to the 
folder or document. Then, give the users permission to read, read/write, or 
read/write/delete the folder or document. The permission level determines the actions 
users can take on a folder or document. 

 

Permission Description 

Read You can do the following: 

■ Open current and prior versions of a document. 

■ Check out current and prior versions of a document. 
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Read/Write You can do the following: 

■ Open, read, copy, and move documents. 

■ Check in or check out documents. 

■ View check in/check out history. 

■ View document versions. 

■ View and modify document properties and 
permissions. 

■ Attach processes for documents. 

■ Add new folders and documents. 

Read/Write/Delete You have all the read/write permissions, plus you can 
move and delete documents and folders. 

All Document Manager participants are automatically given the read permission. The 
project manager, program manager, resource manager, or CA Clarity PPM administrator 
grants the other permissions. 

 

How to Create a Folder 

Folders can stand alone and can contain documents, or a folder can serve as a top-level 
folder that contains subfolders. Both top-level folders and subfolders can contain 
documents. 

To view the list of folder actions, from a Knowledge Store or Document Manager page, 
click a folder Actions menu. Your access rights and permissions determine the actions 
that display.  

You can create subfolders for a top-level folder, and subfolders for a subfolder. When 
you create a subfolder, the application automatically gives read/write access to that 
subfolder to those resources that you selected at the top level. These resources are 
named participants. You can select individual resources from the existing participant 
group and can give access to more users. 

 

Create a Folder for a Project or Program 

You can create a folder for a project or a program. 

Follow these steps: 

1. Open Home, and from Portfolio Management, click Projects or Programs. 

2. Open the project or program, and click Collaboration.  

3. Select New Folder from the folder Actions menu.  

4. Complete the requested information and save your changes. 
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Create a Folder for a Resource 

You can create a folder for a resource. 

Follow these steps: 

1. Open Home, and from Resource Management, click Resources. 

2. Open the resource or role, and click Document Manager. 

3. Select New Folder from the folder Actions menu.  

4. Complete the requested information and save your changes. 
 

How to Manage a Folder 

You can manage a folder in the following ways: 

■ Add a Document to a Folder (see page 80). 

■ Download Files from Folders (see page 81). 

■ Edit the Folder Properties or Permissions (see page 82). 
 

Add a Document to a Folder 

You can add a maximum of five files to a folder at one time.  

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource.  

2. Open the Actions menu for the folder, and click Add Documents.  
 

3. Select the files to add and complete the requested information. The following fields 
require explanation: 

 

 

 

Enable Check Out 

Indicates if resources with appropriate access can check out and edit the file. 
 

Enable Versioning 

Indicates if resources with appropriate access can create another version of the 
file. 

4. Click Add. 
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Download Files from Folders 

Use the Download All or the Incremental Download option to download files from a 
selected folder to a local zip file. The absence of these options on the Actions menu 
implies that you do not have the required permissions to download the files. 

You can download: 

■ All the files and subfolders in a selected folder 

■ A subset of files from the selected folder. The subset includes those files that have 
changed since you last downloaded and those files not yet downloaded. 

The zip file name is the name of the folder by default. You can select where to download 
the file. When you download files from a folder, the file structure is not maintained in 
the saved zip file. 

Important! Enable the Enable Document Download setting before you download files. 
 

Download All Files 

You can download all the selected files, including files in subfolders. 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource.  

2. Open the Actions menu for the folder, and click Download All.  

If the size exceeds the maximum for download set by your administrator, download 
a subset of files from the folder.  

3. Save the zip file. 
 

Download Files Incrementally 

You can download a subset of files from a selected folder. The zip file includes only files 
that have changed since you last downloaded them and files not yet downloaded. 

 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource.  

2. Open the Actions menu for the folder, and click Incremental Download.  

If the size exceeds the document download maximum set by your administrator, 
download one file at a time. 

3. Save the zip file. 
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Edit the Folder Properties or Permissions 

When you add resources to a folder, they are automatically grouped as participants with 
read/write access to this folder. The user who creates the folder is automatically given 
read, write, and delete access to the folder. You can change the permissions at any time. 

 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource.  

2. Open the Actions menu for the folder, and complete one of the following steps: 

■ Click Properties to edit the folder properties. 

■ Click Permissions to edit the folder permissions. 

Note: Select Cascade Permissions to allow a resource to transfer the rights to any 
documents and subfolders in the current folder. 

3. Save your changes. 
 

How to Manage Documents 

While you can check out a document to edit it, you can also open it in read-only mode 
for viewing purposes only. 

You can manage your documents in the following ways: 

■ Check Out Documents (see page 82). 

■ Edit the Document Properties and Permissions (see page 83). 

■ Copy or Move a Document (see page 84). 

■ Work with Document Versions (see page 84). 

■ Work with Document Processes (see page 85). 
 

Check Out Documents 

To edit a document, check it out of a folder. When you are finished, check the document 
back in. If the document versioning is enabled, another version of the document is 
created automatically. 
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Check Out 

You can check out a document for editing. 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource.  

2. Locate the document, and from the document Actions menu, click Check Out.  

3. Save the document to your desktop, and select a location for the file. 

4. Click OK. 
 

Undo Check Out 

Only the user who checked out the document originally can undo a check out. Undoing 
a check out unlocks the document, allowing others to check out the document.  

Select Undo Check Out from the document Actions menu to undo a document check 
out. 

 

Check In 

Click Check In from the document Actions menu. Browse for the updated copy in the 
location that was selected when you checked out the document. 

 

Edit the Document Properties or Permissions 

The user who added the document can update the document properties.  

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource. 

2. Open the Actions menu for the document, and complete one of the following steps:  

■ Click Properties to edit the folder properties. 

■ Click Permissions to edit the folder permissions. 
 

3. Save your changes. 
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Copy or Move a Document 

You can copy or move a document. 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource.  

2. Locate the document to copy or move to a different folder, and from the document 
Actions menu, complete one of the following steps: 

■ Click Copy. 

■ Click Move. 
 

3. Select the destination folder in the Select Placement section. 

4. Select the Notify Resources/Groups check box for users with access to this 
document notified about the copy action. 

5. Click Copy. 
 

Work with Document Versions 

You can use the document versioning to save a separate version of a document each 
time you check it in. To use the document versioning, enable the document for 
versioning. 

When you enable versioning, you can: 

■ Open and view the previous versions of a document, but you cannot modify it.  

■ Copy a specific version of a document to a different folder. You require the 
permissions to revise the document after copying it. 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource. 

2. Locate the document, and from the document Actions menu, click Versions.  
 

3. Open the document version Actions menu, and complete one of the following 
steps: 

■ Select Open. 

■ Select Copy. 
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Work with Document Processes 

Document processes can be effective when routing a document through an approval 
process. A document process can link to any associated project or program. You can 
send notifications and action items from the document process to the project roles and 
resources.  

The Available Processes page lists all the document-related processes that your CA 
Clarity PPM administrator has created. You can use this page to start or delete a 
process. The Initiated Processes page lists the in-progress or completed processes. You 
can use this page to cancel a process. 

To view the Available or Initiated Processes page, open the Knowledge Store, and from 
the document Actions menu, click Processes. 

 

Follow these steps: 

1. Open the Knowledge Store page for a specific program or project, or the Document 
Manager page for a resource. 

2. Locate the document, and from the document Actions menu, click Processes.  

3. Click Available.  

4. Select the process and complete one of the following steps: 

■ Click Start. 

■ Click Delete. 
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Chapter 11: How to Create, Configure, and 
Manage a Dashboard 
 

This section contains the following topics: 

Uses of Dashboards (see page 87) 
Review the Prerequisites for Dashboards (see page 91) 
Plan the Dashboard (see page 92) 
Create a Dashboard (see page 92) 
Configure the Dashboard Layout (see page 93) 
Manage the Dashboard (see page 95) 

 

Uses of Dashboards 

You can use the personal dashboards to display the specific information you want to 
see. The personal dashboards help you perform the following tasks: 

■ Create custom portlets for a personal dashboard. If you have the appropriate access 
rights, you can use stock portlets.  

■ Create a tabbed dashboard for additional pages, if you have more portlets than you 
want to show on one page. 

 

■ View dashboards that other users have shared with you. 

■ Export dashboard content or an individual portlet in a dashboard to Microsoft Excel 
or PowerPoint. 

 

Dashboard and Portlet Differences 

The following table highlights the functional differences between a dashboard and 
portlet page. 

  

Functionality Dashboard Portlet Page 

Exported Output ■ Fit to page  

■ One portlet per slide or 
sheet 

■ Fit to page 

Sharing with specific 
users 

■ Yes ■ No 



Uses of Dashboards 

 

88  Basics User Guide 
 

Functionality Dashboard Portlet Page 

Page type ■ Page with tabs 

■ Page without tabs 

■ Page with tabs 

■ Page without tabs 

Portlet layout ■ Two-column templates 

■ Three-column templates 

■ Two-column templates 

■ Three-column 
templates 

■ Row layout 
 

Dashboard Examples 

The following examples show how team members and a team manager can use a 
dashboard. 

Example: Monitoring Project Status 

Karen, a team member who tracks the project information for multiple projects, creates 
a dashboard with tabs. From the details page of the new dashboard, she creates the 
portlets to show the dashboard data. The portlets include the following information: 

■ Project Risks 

■ Budget 

■ Resource Allocation 

■ Milestones 
 

Karen configures her dashboard by determining which portlets to present on each tab. 
Then, Karen adjusts the layout of portlets on each tab by dragging-and-dropping the 
portlets into position on the tab layout section. She adds a filter that gives her the ability 
to filter information for all of the portlets at the same time. When the dashboard is 
complete, she views the dashboard, filters for the information that she wants, and 
exports a copy to PowerPoint as a test. 

 

Before each weekly team meeting, she views the dashboard to monitor her projects, 
exports the results to PowerPoint, and provides the information to her team leader. The 
team leader includes the PowerPoint slides in the regular team meeting agenda to 
provide status.  
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Example: Completing Development Tasks and Fixing Software 

Roberto, a team member who does not have the right to create dashboards, navigates 
to Dashboards. Roberto can see two dashboards that his team manager shares with 
him: Security Development Team and Weekly Time Entries. Roberto views the Security 
Development Team dashboard. He sees that he has five assigned development tasks 
and three software bugs. He clicks the first task to get more information and starts 
working on the task. 

 

Example: Sharing a Dashboard with an OBS Development Unit 

Stan, the team manager creates a dashboard with two tabs: Team Work and Team 
Status. He populates the tabs with portlets that were created beforehand and with 
stock portlets to which he has access. Stan adds the following portlets: 

■ Team Members 

■ Bugs and Issues by Components 

■ Tasks by Team Member 

■ Time Entries by Team member 

■ Work Completed and Work Remaining 
 

Stan does not allow others to personalize his dashboard. He shares the dashboard with 
the entire OBS development unit and the executive management team to view portlets 
in the dashboard. 

 



Uses of Dashboards 

 

90  Basics User Guide 
 

The following diagram shows how a user creates, configures, and manages a dashboard: 
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Follow these steps: 

1. Review the Prerequisites (see page 91). 

2. Plan the Dashboard (see page 92). 

3. Create a Dashboard (see page 92). 

4. Configure the Dashboard Layout (see page 93). 

■ Configure the Dashboard Without Tabs (see page 94). 

■ Configure the Dashboard With Tabs (see page 94). 

■ Add a Tab to the Dashboard (see page 94). 

■ Add a Portlet to the Dashboard (see page 95). 

5. Manage the Dashboard (see page 95). 

■ Share the Dashboard (see page 96). 

■ Assign Manager Rights to a User (see page 96). 

■ Personalize the Shared Dashboard (see page 97). 

■ Publish the Dashboard (see page 97). 

■ Export the Dashboard (see page 98). 

■ Export the Portlet (see page 98). 

■ Remove a Portlet from the Dashboard (see page 99). 
 

Review the Prerequisites for Dashboards 

Verify that you meet the following prerequisites: 

■ Global Access Rights Assigned. Your CA Clarity PPM administrator assigns you these 
required global access rights to work with dashboards and portlets.  

 

Access Right Description 

Dashboard - Create Allows you to create a dashboard. 

Dashboard - Navigate Provides access to the Dashboards link in the Personal 
menu. 

Portlet - Create Allows you to create a portlet. 

Portlet - Navigate Provides access to the Portlets link in the Personal menu. 
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■ Access Rights to the Dashboard Information. You must also have access rights to 
the information displayed on a dashboard. Access to a dashboard does not 
automatically include access to the project information. If you share a dashboard, 
the user with whom you share, must also have the right to see the shared 
information.  

Note: Sharing a dashboard with a user does not automatically ensure that the user can 
see the dashboard. The user must separately have the Dashboard - Navigate right 
assigned to them so that the Dashboard option appears in the Personal menu. 

 

Plan the Dashboard 

Before you set up a dashboard, consider the following points: 

■ The number of portlets you plan to include.  

This information helps you to determine if you need tabbed pages. 
 

■ How the portlets present information.  

You can plan for the visual presentation of graphs or the statistical presentation 
that is possible with rows and columns. 

 

■ The users with whom you can share.  

Some users do not have rights to the information you are presenting in portlets. In 
addition, consider individuals to whom you can give manager privileges for your 
dashboard. 

 

Create a Dashboard 

When you create a dashboard, you are given the ability to view and manage the 
dashboard. 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Click New. 
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3. Complete the requested information. The following fields require explanation. 

Type 

Specifies if the dashboard is a single page or tabbed pages. 

Note: Select Page with Tabs to add tabs to the dashboard. 

Personalizable 

Specifies if the users with whom you share a dashboard can change the copy 
that appears in their dashboards list. Any personal changes to a dashboard are 
local to the user who makes them. The changes are overwritten when the 
owner of the dashboard, or a user with administrator privileges, publishes new 
changes. 

4. Save your changes.  
 

Configure the Dashboard Layout 

A layout template provides a guideline for your displayed dashboard. A layout template 
determines the number of portlets appearing in a row and the percentage width for 
each portlet position. If a portlet is large (a grid portlet with many columns), it can 
exceed the allotted space in a row. In this case, the portlet is not truncated. However, 
you can accommodate a larger size by moving portlets to another row when the 
dashboard displays. As a result, a displayed dashboard does not look exactly the way 
you design it in the Content and Layout section. 

 

To lay out a dashboard, select a template layout and then add portlets and drag them to 
the position in the Content and Layout section. Use the Dashboard Details page to 
complete the dashboard layout. From the details page, you can also complete the 
following tasks: 

■ Create new portlets. 

■ Add portlets that you create and stock portlets to which you have access. 
 

■ Select a layout template. 

■ Drag-and-drop portlets into the appropriate positions. 
 

■ View the dashboard. 

■ Export dashboard information. 

■ Share the dashboard. 
 

You can configure the dashboard layout in the following ways: 

■ Configure the Dashboard Without Tabs (see page 94). 

■ Configure the Dashboard With Tabs (see page 94). 
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Configure the Dashboard Without Tabs 

You can add portlets to a dashboard. The following steps assume the dashboard and 
portlets are already created. 

 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard. 
 

3. Click the Add Portlet icon in the Content and Layout section. 

4. Select the check box for each portlet and click Add. 
 

5. Select the layout template. 

You can mouseover each template in the list for the column format it represents. 
The template that you select determines how many columns appear on the 
dashboard and the percentage of the dashboard allotted to each column. 

 

6. Drag-and-drop to arrange the portlets in the order you want. 

7. Save your changes. 
 

Configure the Dashboard with Tabs 

When you create a dashboard, designate the Type as Page with Tabs to add tabs to the 
dashboard.  

You can use the Content and Layout section to configure a dashboard with tabs in the 
following ways: 

■ Add a tab to the dashboard (see page 94). 

■ Add a portlet to the dashboard (see page 95). 
 

Add a Tab to the Dashboard 

You can add a tab to the dashboard and add portlets to that tab. The following steps 
assume that the dashboard is already created. 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard with the Page with Tabs type. 
 

3. Click the Add Tab icon in the Content and Layout section. 

4. Complete the requested information and save your changes. 
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Add a Portlet to the Dashboard 

You can add portlets to a dashboard. The following steps assume the dashboard and 
portlets are already created. 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard. 

3. Select the tab to be configured in the Contents and Layout section. 
 

4. Click the Add Portlet icon in the Content and Layout section. 

5. Select the check box for each portlet to add to the dashboard, and click Add. 

6. Select the layout template. 

You can mouseover each template in the list for the column format it represents. 
The template that you select determines how many columns appear on the 
dashboard and the percentage of the dashboard allotted to each column. 

 

7. Drag-and-drop the portlet icons into the position on the tab. 

8. Save your changes. 

9. Repeat these steps to configure each tab. 
 

Manage the Dashboard 

You can manage the dashboard in the following ways: 

■ Share the Dashboard (see page 96). 

■ Personalize a Shared Dashboard (see page 97). 

■ Publish the Dashboard (see page 97). 

■ Export the Dashboard (see page 98). 

■ Export the Portlet (see page 98). 

■ Remove a Portlet from the Dashboard (see page 99). 
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Share the Dashboard 

You can share a dashboard with a user, a group of users, or an OBS group. When you 
share, the dashboard appears in the user list of dashboards for viewing. By default, 
when you share with a user, they have view only rights. 

You can also assign manager rights to a user. The rights let the user change and publish 
the dashboard to all who can view the dashboard. Give the permission to only a few 
trusted users. 

 

You can also allow a user to change the shared copy of the dashboard that appears in 
the user dashboard list. The changes apply only to the user version and other users 
cannot view them. The changes remain in the user copy until the owner of the 
dashboard, or a user with manager rights publishes changes. The latter overwrites all 
personalized changes. 

 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard, and open the Actions menu, and click 
Sharing. 

 

3. Click the appropriate menu to add a resource, group, or OBS unit. 

Click Full View to see the names of users who have access to the dashboard through 
means other than sharing. 

4. Click Add. 
 

5. Select the individuals, groups, and OBS groups with whom you want to share, and 
click Add. 

 

Assign Manager Rights to a User 

You can assign rights to a user. 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard, and open the Actions menu, and click 
Sharing. 

 

3. Locate the user to assign manager rights for your dashboard on the Resources page. 

4. Select Manager from the drop-down in the Access Right column. 

5. Save your changes. 
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Personalize a Shared Dashboard 

You can personalize another user dashboard that is shared with you if you have 
Manager access to that dashboard. The changes that you make are visible only to you 
and not to other users who view the dashboard. If the creator of the dashboard 
modifies and publishes the dashboard, your personal changes are lost. 

 

You can personalize: 

■ Dashboard name and description. 

■ Dashboard content. You can add and remove portlets. 

■ Page filters for the portlets. 

■ Portlet layout. 
 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard, open the Actions menu, and click View 
Dashboard. 

3. Click Personalize. 
 

4. Select the appropriate menu and modify the dashboard.  

5. Save your changes. 
 

Publish the Dashboard 

A dashboard manager can publish changes to a dashboard. When a dashboard manager 
publishes, the new changes affect every user who can view the dashboard. If a user 
personalizes the dashboard, the changes are overwritten by the new changes being 
published. 

 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Click the name of the dashboard to change and publish. 
 

3. Change the dashboard, if necessary, and click Save. 

4. Click Publish, and then click Yes to publish. 
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Export the Dashboard 

You can export a dashboard from the details page, or from a dashboard that is displayed 
for viewing. You can export the contents of a dashboard or an individual portlet in a 
dashboard to Microsoft Excel or PowerPoint. The maximum export size for Excel and 
PowerPoint is 300 records. However, there is no limit when you use the Export to Excel 
(Data Only) option. 

 

You can fit the exported information to a page in PowerPoint. You can also place each 
exported portlet on a separate page. This approach avoids having all the portlets fitted 
onto a single page as they appear in a dashboard. 

■ To export each portlet to a separate page with the current dashboard size, select 
One Portlet per Slide/Sheet.  

■ To export each portlet to a separate page and fit the portlet to the page, select both 
One Portlet per Slide/Sheet and Fit to Page. 

■ To fit all the exported portlets on a single sheet or page, verify that both check 
boxes are clear. Some portlets can be truncated if the number of portlets is larger 
than the PowerPoint page can accommodate while you export to PowerPoint.  

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard. 
  

3. Select the appropriate check boxes for the Export field, to indicate how you want 
the portlets to appear. 

4. Open the Actions menu and click Export to Excel or Export to PowerPoint. 
 

Export the Portlet 

To export an individual portlet, first display the dashboard. Some stock portlets are 
restricted and cannot be exported.  

If you are exporting a chart portlet, the chart displays in native Microsoft Office chart 
format. 

 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard, open the Actions menu, and click View 
Dashboard. 

 



Manage the Dashboard 

 

Chapter 11: How to Create, Configure, and Manage a Dashboard  99  
 

3. Open the Options menu on the portlet that you want to export and select one of 
the following options: 

■ Export to Excel (Data Only). Includes the portlet information but does not 
include charts. 

■ Export to Excel. Includes the portlet information and any portlet charts. 

■ Export to PowerPoint. Includes the portlet information and any portlet charts. 

The File Download dialog appears. 

4. Click Open to display the file without saving, or click Save to save the file. 
 

Remove a Portlet from the Dashboard 

Removing a portlet from a dashboard does not delete it. To delete the portlet 
permanently, delete it from the portlets list page. 

Follow these steps: 

1. Open Home, and from Personal, click Dashboards. 

2. Open the details page for the dashboard. 
 

3. Click the Remove icon on the portlet in the Content and Layout section. 

4. Save your changes. 
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Chapter 12: Global Search Tool 
 

This section contains the following topics: 

Uses of the Global Search Tool (see page 101) 
Perform a Basic Search (see page 101) 
Perform an Advanced Search (see page 102) 
Global Search Techniques (see page 102) 

 

Uses of the Global Search Tool 

The Global Search tool appears on the global toolbar. Use the global search field to 
perform a simple global search to look for specific documents and forms. Use the 
Advanced link to set additional search criteria to refine your search results. 

You can search for information that is saved in the application at any time. However, by 
default, 5 minutes elapse before new information can be searched. Your administrator 
determines and can change the amount of time. 

 

Perform a Basic Search 

To perform a basic search, click the Search icon and enter all or part of the term, then 
click Search. The search results list contains only items that you have the right to view.  

Keep in mind the following guidelines: 

■ To perform a wildcard search, enter all or part of the search criteria. You do not 
have to append your entry with a wildcard character (*). Basic search is not 
case-sensitive. For example, the entries Orange, orange, and ORANGE all return the 
same results. 

■ If you enter the search phrase, Resource Profile List without quotations, the 
application searches for items that contain any of these words in any order. 
However, if you enter the search phrase in quotation marks ("Resource Profile 
List"), only instances of the exact string are returned. 

■ Do not use the following characters in basic searches: 

@ = [] {} <> 
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Perform an Advanced Search 

Use the Advanced Search page to set additional criteria to refine your search results. 

Use the fields and options on the page to narrow your search. You can search according 
to one or any combination of the criteria. The search results display only for those items 
you have permissions to view or edit. 

 

Global Search Techniques 

Use the following techniques to perform global searches: 

■ Wildcard characters 

■ Boolean operators 

■ Subqueries 
 

Use Wildcard Characters in a Global Search 

With the Global Search tool, you can perform single and multiple character wildcard 
searches. Do not use the "*" or "?" symbols as the first character of a search. 

Single Character Wildcard Search 

The single character wildcard search looks for terms that match with the single 
character replaced. To perform a single character wildcard search, use the "?" 
symbol.  

Example: To search for text or test, enter the query:  

te?t 

Multiple Character Wildcard Search 

Multiple character wildcard searches look for zero or more characters. To perform a 
multiple character wildcard search, use the "*" symbol.  

 

Example: To search for test, tests, or tester, enter the following text:  

test* 

You can also use wildcard searches in the middle of a term.  

Example:  

te*t 
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Use Boolean Operators in a Global Search 

The Boolean operators let you perform global searches using multiple terms that are 
combined through logic operators. The following Boolean operators are supported: 
AND, +, OR, NOT, and -. 

Enter the Boolean operators in all caps. 

OR 

OR is the default conjunction operator, which means no Boolean operator exists 
between two terms, OR is used. The OR operator links two terms and finds a 
matching document if either of the terms exist in a document. This operation is 
equivalent to a union with sets. You can use the symbol || in place of the OR 
operator.  

Example: To search for documents that contain "jakarta apache" or "jakarta", use 
the query:  

"jakarta apache" "jakarta" 

or, 

"jakarta apache" OR "jakarta" 

or, 

"jakarta apache" || "jakarta" 
 

AND 

The AND operator matches documents in which both terms exist anywhere in the 
text of a single document. This operation is equivalent to an intersection using sets. 
You can use the special character && in place of the AND operator. 

Example: To search for "jakarta apache" and "jakarta CA Clarity PPM", use the 
query: 

"jakarta apache" AND "jakarta CA Clarity PPM" 

or, 

"jakarta apache" && "jakarta CA Clarity PPM" 
 

+ (required) 

The +, or required, operator requires that the term after the + operator to exist 
somewhere in a field of a single document or form. 

Example: To search for documents containing "jakarta" with or without "CA Clarity 
PPM", use the query: 

+"jakarta CA Clarity PPM" 
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NOT 

The NOT operator excludes documents or forms that contain the term after the 
NOT operator. You can use the exclamation mark symbol (!) instead of the NOT 
operator.  

Example: To search for documents that contain "jakarta apache" but not "jakarta 
CA Clarity PPM", use the query: 

"jakarta apache" NOT "jakarta CA Clarity PPM" 

or, 

"jakarta apache" ! "jakarta CA Clarity PPM" 

The NOT operator cannot be used with a single term. This query returns no results:  

NOT "jakarta apache" 
 

- (prohibit) 

The -, or prohibit, operator excludes documents that contain the term after the - 
operator.  

Example: To search for documents and forms that contain "jakarta apache" but not 
"jakarta CA Clarity PPM", use the query: 

"jakarta apache" - "jakarta CA Clarity PPM" 
 

Form Subqueries in a Global Search 

Subqueries allow you to control the Boolean logic during global searches by grouping 
clauses with parentheses. For example, to search for documents and forms that contain 
either "jakarta" or "apache" and "website", include the following sub query in the query: 

("jakarta" OR "apache") AND "website" 

The preceding query verifies that "website" exists and that either term, "jakarta" or 
"apache", possibly exists. 

 

Escape Special Characters in Global Searches 

Escape special characters in global searches properly. To escape these characters, use 
the "\" (backslash) character before the special character. For example, to escape the 
special characters in a global search for (1+1):2, use the following query: 

\(1\+1\)\:2 
 

The following table lists the special characters: 

 

Special Character Description Rule 

+ plus sign \+ 

- minus sign \- 
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Special Character Description Rule 

&& double ampersand \&& 

|| double solid vertical bars \|| 

! exclamation point \! 

( left parenthesis \( 

) right parenthesis \) 

{ left curly brace \{ 

} right curly brace \} 

[ left square bracket \[ 

] right square bracket \] 

^ circumflex \^ 

" quotes \" 

~ tilde \~ 

* asterisk \* 

? question mark \? 

: colon \: 

\ backslash \\ 
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Chapter 13: How to Submit a Timesheet 
 

This section contains the following topics: 

How to Submit a Timesheet (see page 107) 
Configure Your Timesheet (see page 112) 

 

How to Submit a Timesheet 

As an application user, you are responsible for tracking the number of hours that you 
work on specific tasks. Tracking work time using timesheets allows companies to plan 
budgets for complex projects, track the allocation of resources, implement charge 
codes, and so on. Therefore, your manager can ask you to track the hours you spend on 
specific tasks for specific projects. Depending on the policy of your company, your 
manager can also want you to track the hours you spend on tasks under various charge 
codes and input methods. As an application user, you track your working hours, using 
timesheets. 
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The following graphic describes how an application user submits a timesheet. 

 
 

Follow these steps: 

1. Access an Unsubmitted Timesheet (see page 109) 

2. Populate a Timesheet (see page 109) 
 

3. Add Entries to a Timesheet Manually (see page 109) 

4. (Optional) Specify and Split Entry Input Type and Charge Codes (see page 110) 
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5. (Optional) Add Indirect Row Timesheet Entries to a Timesheet (see page 110) 

6. Enter Work Hours on a Timesheet (see page 110) 
 

7. Submit a Timesheet for Approval (see page 111) 

8. Correct a Returned Timesheet (see page 111) 
 

Access an Unsubmitted Timesheet 

After your manager registers you as a user, you can start to work with CA Clarity PPM. 
To start tracking time with timesheets, access your unsubmitted timesheets. 

Follow these steps: 

1. Open Home, and from Personal, click Timesheets. 

The unsubmitted timesheets appear. 

2. Click the Timesheet icon next to a timesheet. 

Note: You can also click the Current Timesheet icon (clock symbol) at the top right 
of the page to open your current week timesheet. 

 

Populate a Timesheet 

When you first open a timesheet, the timesheet is blank, containing no tasks. To 
prepopulate your current timesheet with tasks, click the Populate button on the 
timesheet page. 

Note: Depending on how your CA Clarity PPM administrator sets up your timesheet 
options, prepopulating a timesheet does one of the following tasks: 

■ Copies all of your assignments to the timesheet. 

■ Copies the timesheet entries and actuals from the most recently submitted 
timesheet to your current timesheet. 

 

Add Entries to a Timesheet Manually 

After you populate your timesheet with tasks, you can add more tasks from your 
project. To add more tasks to a timesheet, use the add task feature. 

Follow these steps: 

1. Click the Add Task button on the open timesheet. 

A page opens with a list of tasks available to the user. 

2. Select the check box next to the tasks you want to add to the timesheet, and then 
click the Add button at the bottom of the page. 
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Specify Entry Input Type and Charge Codes 

Input type and charge codes are used for payroll purposes. If your company uses these 
codes, your project manager can make them available to you in your timesheets. Your 
manager can also want you to split entries in this process. Verify the policy of your 
company on input type and charge codes before submitting your timesheets.  

Follow these steps: 

1. Open the timesheet. 

2. Select an input type code or charge code from the Input Type Code or Charge Code 
drop-down for the desired time entry row. 

 

3. (Optional) Select the check box next to the timesheet entry you want to split it, and 
click Split. 

Note: This step is appropriate when your manager wants you to enter specific hours 
under two different charge codes. After you split the entry, you can select a type 
code or charge code from the Input Type Code or Charge Code field for the second 
entry. 

4. Save the changes. 
 

Add Indirect Row Timesheet Entries to a Timesheet 

Your manager can ask you to add rows to a timesheet under an indirect category. 

Follow these steps: 

1. With your timesheet open, click New Indirect Row. 

2. Select the Charge Codes or Input Type Codes (if applicable). 

3. Save the changes. 
 

Enter Work Hours in a Timesheet 

To record the time you worked each day on specific task assignments, use the timesheet 
page of your current work period. 

Note: You can also distribute the number of hours for a single task evenly across all 
working days, by entering the total number of hours you worked in the Total column for 
the time entry row. If you enter values in both the Date and Total cells, the Date cell 
value overrides the Total cell value. 
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Follow these steps: 

1. Open the timesheet.  

2. Enter the number of hours you worked on each assignment each day in the Date 
cells of the timesheet. 

3. Save the changes. 
 

Submit a Timesheet for Approval 

Your submitted timesheet goes to your manager for approval. The status of the 
timesheet is Unapproved until your manager approves it.  

Do one of the following: 

■ From the timesheets list page, select the timesheet, and click Submit for 
Approval. 

■ Open the timesheet, and click Submit for Approval. 
 

Correct a Returned Timesheet 

When your manager returns a timesheet for correction, you receive a notification. The 
method of this notification depends on your account settings.  

Follow these steps: 

1. Access your returned timesheet. For example, click the link in the notification from 
your manager. 

Note: The returned timesheet can have notes from your manager about what to 
correct. The Paper and Pencil icons on the timesheet indicate if there are new 
notes. 

2. Make the corrections to your timesheet as needed. 

3. Submit your timesheet for approval. 

Your manager is notified that the corrected timesheet is ready for review and 
approval. 
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Configure Your Timesheet 

You can configure your timesheet to display only the columns that you want to see. 
Select the sorting method for the timesheet and set other timesheet options. 

Follow these steps: 

1. Open the timesheet to configure.  

2. Click the Configure link. 
 

3. In the Content and Layout section, select the column labels to display on the 
timesheet from the Available Columns list. Then, move them to the Selected 
Columns list. 

 

4. Specify the following sorting options: 

Default Sorting Column 

Specifies the column to sort the tasks on the Timesheet page. 

Values: 

■ Investment. The name of the project that includes the task. 

■ Description. The task description. 
 

Sorting Order 

Specifies the order of sorting the column. 

Values: 

■ Ascending. Sorts the column from lowest value to highest. 

■ Descending. Sorts the column from highest value to lowest. 
 

5. In the Time Entry Options section, complete the following fields: 

Auto-Populate 

Automatically populates all subsequent timesheets according to the rule set. 

Values: 

■ Off. Populates new timesheets with task assignments that are currently 
open. The open assignments have a date range within the time periods of 
the new timesheets and have non-zero ETC.  

■ Copy time entries from the previous timesheet. Populates new timesheets 
with the task entries from the current timesheet. 

■ Copy time entries from the previous timesheet and include actuals (actuals 
are not copied for incidents). Populates new timesheets with the task 
entries and daily actuals from the current timesheet. Actuals for one-time 
time entries, such as vacation or sick time, are not copied. 
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Display Unit 

Indicates the measure of time entries by hours or days. 

Decimal Place 

Indicates the number of decimal places for the time entry display unit selected. 

6. Save your changes. 
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Chapter 14: Advanced Reporting 
 

This section contains the following topics: 

Advanced Reporting Structure and Content (see page 115) 
Managing Ad Hoc Views and Reports (see page 117) 
Running and Scheduling an Advanced Report (see page 119) 
Advanced Reporting Domains (see page 122) 

 

Advanced Reporting Structure and Content 

Advanced Reporting allows you to create an ad hoc view of CA Clarity PPM data that you 
can save as a report and share using different formats. You configure each ad hoc view 
and its corresponding report by selecting the data that you want to include. You can run 
a report immediately or you can set up a schedule. In either case, you control the output 
method and format. 
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The following diagram shows the Advanced Reporting components: 

 

The CA Clarity PPM Data Warehouse is the main data source for Advanced Reporting. 
The Data Warehouse schema is optimized specifically for reporting. The schema 
includes the Investment, Resource, Portfolio, Timesheet, and Project data. The Data 
Warehouse is populated at scheduled intervals by jobs that load the relevant data from 
the CA Clarity PPM database to the Data Warehouse. The Data Warehouse can be 
extended to include custom objects and attributes. 

CA Clarity PPM provides a set of domains that contain the most frequently used data. 
When you create an ad hoc view, you select from a list of the available domains. A 
domain provides a business view of the CA Clarity PPM Data Warehouse. A domain 
limits your access to data based on your security permissions. For example, if a user is 
permitted to access specific projects and resources in CA Clarity PPM, that user can 
access the same projects and resources in the Advanced Reporting domains. If you add 
custom objects or attributes to the product, these custom objects and attributes can 
also be included in the domains. 

Note: To view the domains and reports, you must have the PMO Accelerator add-in with 
Jaspersoft Advanced Reporting content. See the PMO Accelerator for Jaspersoft 
Advanced Reporting Product Guide or your administrator for more information. 
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You create ad hoc views in the form of charts, tables, and cross tabs that let you analyze 
data from the domains. You can also use the ad hoc views to generate reports, which 
you can share or output in the following ways: 

■ Single report standalone 

■ Word, PDF, Excel, Powerpoint documents or other formats 

■ Email attachment 

Note: Advanced Reporting uses the JasperReports Server (which is integrated with CA 
Clarity PPM) to manage ad hoc views and reports. For information about the 
JasperReports Server, see the Jaspersoft Community web site. See the CA Clarity PPM 
Release Notes for the Jaspersoft version that corresponds to your CA Clarity PPM 
release. 

 

Managing Ad Hoc Views and Reports 

Advanced Reporting lets you create ad hoc views of CA Clarity PPM data, save the views 
as reports, and export or email the reports. You customize each ad hoc view and report 
by selecting the domains and fields that you want to include. 

Advanced Reporting uses the JasperReports Server to manage ad hoc views and reports. 
When you select the Advanced Reporting option from CA Clarity PPM, the Advanced 
Reporting page appears. This page, and all pages that are opened from this page, are 
based on the Jaspersoft application. 

 

Note: For information about using Jaspersoft, access the Jaspersoft Community web site 
and click the Documentation link or Docs link. On the Documentation page, select the 
version of Jaspersoft that corresponds to your CA Clarity PPM release. Then click the link 
for the JasperReports Server User Guide. Refer to the CA Clarity PPM Release Notes for 
the Jaspersoft version that corresponds to your CA Clarity PPM release. 

 

Review the Prerequisites 

To manage ad hoc views and reports, your administrator sets up Advanced Reporting for 
you and grants you the appropriate access rights. If you do not see the Advanced 
Reporting link in CA Clarity PPM (by clicking Home, Personal), contact your 
administrator. 

To work with the Advanced Reporting content that is provided with the product, you 
must have the PMO Accelerator and the Advanced Reporting content. See your 
administrator to verify that the prerequisites have been met. 

 

http://community.jaspersoft.com/
http://community.jaspersoft.com/
http://community.jaspersoft.com/
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Create an Ad Hoc View and Report 

Use Advanced Reporting to create ad hoc views and reports by selecting fields from the 
domains. Then you can run the reports or schedule the reports to run at a later time. 

Note: For descriptions of the domains, see Advanced Reporting Domains (see page 122).  

Follow these steps: 

1. Open Home, and from Personal, click Advanced Reporting. 

The Advanced Reporting page opens. You see links to the different Advanced 
Reporting functions (in blocks). The functions that you can see and access depend 
on your user role. The following blocks require explanation: 

Ad Hoc Views 

Allows you to create a limited view of your data that you can use to prepare 
reports or access a list of existing ad hoc views. 

Reports 

Allows you to create and format reports from existing ad hoc views or access a 
list of existing reports. 

 

2. Click the Ad Hoc Views Create link, select a domain, and click Choose Data. 

Note: Click the Ad Hoc Views View List link to see the existing ad hoc views that you 
can access. 

3. Select the domain fields that you want to have available for your ad hoc view. Click 
Table, Chart, or Crosstab (depending on the format that you want). 

Important! We do not recommend that you select all fields in the domain. For best 
performance, use the following guidelines to create smaller views: 

■ For the Investment Management, Project Management, Application 
Management, Idea Management, and Resource Management domains, select 
one metric set for each view. The metric sets are Summary, Weekly, Calendar, 
and Fiscal. 

■ For the Financial Management domain, select one set for each view. The sets 
are Financial Transaction and Plan Data. 

■ For the Time Management domain, select one set for each view. The sets are 
Missing Time and Timesheets. 

4. Create an ad hoc view by selecting fields and measures and adding (dragging) them 
to the new ad hoc view. 
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5. Save the ad hoc view. 

You can save the ad hoc view to the Shared folder or to your own private user 
folder. Other users can access your ad hoc view if you save to the Shared folder. 
Only you can access the ad hoc view if you save to your own user folder. 

Note: Your private user folder can be found under the main Users folder. The main 
Users folder name can appear disabled, but you can expand this folder. The 
subfolders under Users are enabled, so that you can select your own folder to save 
the ad hoc view. 

6. (Optional) Create a report when you save the ad hoc view. Reports allow you to use 
scheduling and more formatting options. 

Note: The Advanced Reporting function uses the JasperReports Server. For 
information about using Jaspersoft with views and reports, access the Jaspersoft 
Community web site and click the Documentation link or Docs link. On the 
Documentation page, select the version of Jaspersoft that corresponds to your CA 
Clarity PPM release. Then click the link for the JasperReports Server User Guide. 
Refer to the CA Clarity PPM Release Notes for the Jaspersoft version that 
corresponds to your CA Clarity PPM release. 

 

Running and Scheduling an Advanced Report 

Advanced Reporting lets you run, schedule, and manage scheduled reports that are 
based on CA Clarity PPM data. You can schedule reports with different output options 
(for example, PDF or Excel) and email reports to people you want to notify. 

 

Review the Prerequisites 

To run and schedule advanced reports, verify that you meet the following prerequisites: 

■ You can see the Advanced Reporting link in the Personal menu under Home. If you 
do not see this link, contact your administrator. 

■ A list of reports exists. If you do not see a list of reports, contact your administrator. 
 

Run or Schedule a Report and Manage Scheduled Reports 

You can run a report immediately or you can schedule it to run at a specific interval and 
frequency. You can also manage your scheduled reports by monitoring the list of 
scheduled reports, changing schedules, or deleting schedules. 

Important! Your report output cannot exceed 500 pages. This limit applies to each 
output format that you select. As a best practice, we recommend that you filter the 
report to limit the output data. Do not use reports to extract large volumes of data. 

 

http://community.jaspersoft.com/
http://community.jaspersoft.com/
http://community.jaspersoft.com/
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Follow these steps: 

1. Open Home, and from Personal, click Advanced Reporting. 

The Advanced Reporting page opens. You see links to the different Advanced 
Reporting functions (in blocks). The functions that you can see and access depend 
on your user role. The following block requires explanation: 

Reports 

Allows you to create and format reports from existing ad hoc views or access a 
list of existing reports. 

 

2. On the Reports block, click View List. 

A list of reports appears. The reports that appear depend on your permissions.  

3. Run a report immediately by selecting and opening a report and entering values for 
the Options on the left. Click Apply. 

Note: The Options act as filters to focus the report on only the data that you want 
to see. 

 

4. Schedule a report to run as a job by right-clicking the report name and selecting 
Schedule. Click Create Schedule. 

The New Schedule page opens with the Schedule tab selected. The following 
graphic shows an example of this page. 

 
 

a. Specify the Schedule. 

Select a schedule definition using a Simple or Calendar recurrence schedule. 

b. Specify Parameters. 

Select the parameters, which are similar to the report filter options. 
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c. Specify Output Options. 

Select output options (for example, PDF, Excel, or Powerpoint) and distribution 
methods. The output options also allow you to specify a locale. Then when the 
scheduled report runs, the report is presented in the specified language. The 
following fields require explanation: 

Formats 

Select a maximum of two options (for example, Powerpoint and Word or 
PDF and Excel). 

 

Output to Repository 

Browse to select the Shared folder (or a subfolder) or your own user folder 
(under Users). Other users can access your report if you save to the Shared 
folder. Only you can access the report if you save to your own user folder.  

Output to Repository Examples: 

■ /shared/reports 

■ /users/username 

We do not recommend that you save your report to the CA PPM folder or any 
of its subfolders. These folders are overwritten during a system upgrade, and 
your reports are then lost. 

 

d. Specify Notifications. 

Select the notifications that you want to send when the scheduler runs. The 
notifications can include the report as an email attachment. The following 
fields require explanation: 

Email Notification To, CC, or BCC 

Enter email addresses, up to a maximum of 200 characters. Separate email 
addresses with commas. You can also enter email aliases, which we 
recommend if you are sending the report to a large number of users. 

e. Click Save. 
 

5. Manage your scheduled reports by changing or deleting the scheduled jobs. 

Note: For information about using Jaspersoft, access the Jaspersoft Community 
web site and click the Documentation link or Docs link. On the Documentation 
page, select the correct version of Jaspersoft that corresponds to your CA Clarity 
PPM release. Then click the link for the JasperReports Server User Guide. Refer to 
the CA Clarity PPM Release Notes for the Jaspersoft version that corresponds to 
your CA Clarity PPM release. 

 

http://community.jaspersoft.com/
http://community.jaspersoft.com/
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Advanced Reporting Domains 

CA Clarity PPM provides a set of domains that contain the most frequently used product 
data. A domain provides a business view of the CA Clarity PPM Data Warehouse. The 
data that you see in the domains has been Data Warehouse enabled by your 
administrator. You select a domain from the ad hoc viewer when you build your ad hoc 
views. A domain limits your access to data based on your security permissions. 

The domain fields are organized into sets and items. The sets act like folders that you 
can expand to view the items. Some examples of domain sets include the General and 
the OBS sets. 

 

Custom attributes are listed and viewable if they are Data Warehouse enabled. Each 
domain has its own custom attributes. 

Important! We do not recommend that you change the domains that are provided with 
the product. To modify a product-provided domain, copy the domain, place it in another 
location in the repository, and make your changes in the copied version. However, the 
dynamic domain updates that CA Clarity PPM performs are not reflected in your copied 
versions. We recommend that you request enhancements to the product domains, 
instead of making these changes yourself. 

 

Domain Terminology 

The following terms are commonly used with the domain descriptions: 
 

Sets and Items. The domains are organized into sets and items. The sets act like folders 
that you can expand to view the items. Some examples of domain sets include the 
General and the OBS sets. Items include fields and measures. 

Fields. Items that display qualitative information, such as name or location, are fields.  
 

Measures. Items that display numeric values or aggregate values are measures. 
Measures are the quantitative values of a record, such as an amount. In domains, all 
items that are based on numeric fields are designated as measures. The items in 
Measures are numeric fields or items for which you can do mathematical calculations. 

Ad Hoc Viewer and Editor. The Ad Hoc viewer and editor is the interactive designer for 
viewing, creating and editing an ad hoc view. With an ad hoc view, you can explore and 
analyze data. Ad hoc views can also be used to create content for reports. 
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Common Characteristics of Advanced Reporting Domains 

The following major characteristics apply to all Advanced Reporting domains. See the 
descriptions of the individual domains for information that is domain-specific. 

■ Object Domains. Domains are provided for the most frequently used objects, 
including the new product investment objects (NPIOs), such as Ideas and 
Applications. In each domain, you can see only the product data that you have 
permission to view. 

When viewing a domain in the ad hoc editor, the Fields section of the left panel lists 
all field properties (such as Investment names, OBS, text fields, and dates). The 
Measures section of the left panel lists all numeric amounts that are related to the 
fields (such as hours and costs). The items in Measures are fields for which you can 
do mathematical calculations. 

 

■ Internal IDs. Each domain contains an Internal ID set. You use internal IDs for 
building dashboards. Internal IDs are primarily used as filters by report developers 
and dashboard developers. These IDs, which are not used in ad hoc views, are the 
same across all domains. You can map these IDs to input controls and you can use 
them for filtering on dashboards.  

Internal IDs are related to objects, not domains. If Investment data exists in multiple 
domains, the same Investment key is available in each domain. 

Note: Dashboards are not provided with CA Clarity PPM. See the Jaspersoft 
documentation for information about how to build dashboards. 

 

■ Custom Folder. The Custom folder appears in a domain if you have custom fields or 
objects (related to the domain objects) that are Data Warehouse enabled. To verify 
that your custom fields and objects are Data Warehouse enabled, see your 
administrator. The Custom folders also include add-in fields. The Custom folder 
always appears as the first set under each object (after the list of object fields). If 
you have multiple objects in a domain, the Custom folder appears under each 
object folder. For example, the Team object includes its own custom team fields in 
a Custom folder under the Team folder. 

If you add custom fields to an object (or if you install an add-in with custom fields) 
and the fields are Data Warehouse enabled, custom sets are created in the 
corresponding domains. The custom fields are included in the Custom sets under 
the related object. 

Note: If a custom object or subobject has a lookup attribute, the key for it is 
included in the Internal IDs folder under the Custom folder. 

 

■ Period Type. When you select period types, select the same period type for both 
Fields (top of left panel on Advanced Reporting page) and Measures (bottom of left 
panel). Selecting different period types for Fields and Measures can produce 
unexpected results. 

■ Domain Sets. Domains are organized into sets and field items. The sets act like 
folders that you can expand to view the field items. Some examples of sets are the 
General and the OBS sets. 
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■ Domain Security. You have access to specific domains based on your role. When 
you open Advanced Reporting, you see only the domains that you can access. 
However, you may not have access to all data in the domains that you can access. 
When you view a domain that you can access, you see all object sets and fields in 
that domain. However, the data that appears for the objects and fields depends on 
your role. 

 

■ Date Fields. Most of the dates in the domains are business dates that are displayed 
without time stamps and time zone conversions. The exceptions are the system 
dates, which display date and time and have time zone conversions applied to 
them. The system dates include Created Date, Last Updated Date, and Warehouse 
Updated Date. 

 

■ PMO Accelerator Fields. The PMO Accelerator fields are dynamically included in the 
domains (similar to custom attributes). However, the internal IDs of the PMO 
Accelerator fields are renamed when they are included in the Data Warehouse and 
the domains. The renaming of the internal IDs occurs only for PMO Accelerator 
fields. All other add-in fields have the same behavior as the custom attributes. 

 

Investment Management Domain 

The Investment Management domain includes information about investments (for all 
investment types) and their corresponding teams. This domain only includes 
information that is common to all investment types. For example, no information about 
assignments is included.  

The Investment Management domain includes financial summary data for Investments, 
but not detailed financial planning or actual transaction data. The detailed financial 
planning and actual transaction data is included in the Financial Management domain. 

 

Custom fields that you add to the Investment object in CA Clarity PPM appear in the 
Investment Management domain (in the Custom set under the Investment set). If you 
add custom fields to the Team object in CA Clarity PPM, those fields appear in the 
Investment Management domain, Custom set under the Team set. 

Custom subobjects that you add to the Investment object appear under the Custom set 
in their own subobject folder (set), for example, “Country”. The name of the subobject 
set is the same as the subobject name. 
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Domain Characteristics 

The following domain characteristics apply to this domain. 

The Investment Management domain contains two main types of data: investment-level 
financial data (summarized for the total Investment and divided into periods) and team 
data (at the team level and by calendar periods). The domain has general information, 
financial information, OBS information, and team information for all team members in 
an investment.  

The Investment Management domain does not have detailed Cost Plan or actual 
transaction detail data. See the Financial Management domain for that information. 

 

Do not mix object types when selecting from Fields and Measures. If you select 
Investment Name in the Fields area, select a total under the Investment Totals in the 
Measures area. Selecting a total from a different Measures object category (for 
example, Team Totals) could produce unexpected results. For Investment data, use 
investment fields and investment measures. To use Team data when creating an ad hoc 
view, select a team member field from the Team folder under Fields and use a team 
amount from the Team folder under Measures. In general, use Investment data (Fields) 
with Investment metrics (Measures) and use Team data (Fields) with Team metrics 
(Measures). 

Use Team data when you want specific data about a team and its members (for 
example, resources or allocation start dates).  

 

Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making ad hoc view selections. For example, use 
calendar period measures (Measures section, left panel) for calendar period fields 
(Fields section, left panel) and use fiscal period measures (Measures section) for fiscal 
period fields (Fields section). Also, do not mix the period types (week, calendar, fiscal). 
Otherwise, you get unexpected results because the data is repeated for each period 
type. 

 

Portfolios. The Investment Management domain includes portfolios (contents and 
properties). You can use the portfolios to filter and group the investment data by 
portfolio when building ad hoc views. 

 

For example, you created a portfolio in CA Clarity PPM with 100 investments. In the 
Investment Management domain, you add Investment Name to the ad-hoc view (drag 
Investment Name from Fields to Columns in the New Ad Hoc View). Then drag Portfolio 
Name (from Fields) to the Filters, select the portfolio (that you created with 100 
investments) from the drop-down, and click Apply. The ad hoc view now only shows the 
100 investments in that selected portfolio. In this way, you are using Portfolios as a 
filtering method of reporting on your investment data. 
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You can also group your data by portfolio in the Investment Management domain. For 
example, you want to see the Total EAC Hours for the investments in each portfolio. You 
add (drag) Investment Name from the Fields area to Columns in the New Ad Hoc View. 
Then you drag Total EAC Hours from the Investment Totals in the Measures area to 
Columns in the New Ad Hoc View. Then you add Portfolio Name (from Fields) to Groups 
in the New Ad Hoc View. Your data is shown organized by portfolio in the format you 
selected (table, chart, pie diagram). 

 

In the Investment Management domain, you are working with actual up-to-date 
investment data. You are not using the portfolio investment snapshot of the data that 
you use during portfolio planning in CA Clarity PPM. Portfolio planning uses a copy of 
the actual investment data. Therefore, the Investment Management domain data does 
not match the data in the CA Clarity PPM portfolios that you use for portfolio planning. 
For more information about portfolio planning, see the Portfolio Management Scenarios 
Guide. 

 

Custom Fields. If you have custom fields that are related to investments, these fields 
appear in a Custom folder in the Investment Management domain. This domain can 
have multiple Custom folders. For example, Team custom fields appear in the Team 
Custom folder. 

 

Application Management Domain 

The Application Management domain contains information about the investments, 
teams, and financials that are related to applications. Items that apply only to 
applications are included in this domain. 

 

Domain Characteristics 

The following domain characteristics apply to this domain. 

The Application Management domain contains two main types of data: investment-level 
financial data (summarized for the total Investment and divided into periods) and team 
data (at the team level and by calendar periods). The domain has general information, 
financial information, OBS information, and team information for all team members in 
an investment.  

The Application Management domain does not have detailed Cost Plan or actual 
transaction detail data. See the Financial Management domain for that information. 
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Do not mix object types when selecting from Fields and Measures. If you select 
Investment Name in the Fields area, select a total under the Investment Totals in the 
Measures area. Selecting a total from a different Measures object category (for 
example, Team Totals) could produce unexpected results. For Investment data, use 
investment fields and investment measures. To use Team data when creating an ad hoc 
view, select a team member field from the Team folder under Fields and use a team 
amount from the Team folder under Measures. In general, use Investment data (Fields) 
with Investment metrics (Measures) and use Team data (Fields) with Team metrics 
(Measures). 

Use Team data when you want specific data about a team and its members (for 
example, resources or allocation start dates). However, for Baseline hours, do not use 
Team data. You can find total Baseline hours summed under Investment data.  

 

Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making ad hoc view selections. For example, use 
calendar period measures (Measures section) for calendar period fields (Fields area) and 
use fiscal period measures (Measures area) for fiscal period fields (Fields section). Also, 
do not mix the period types (week, calendar, fiscal). Otherwise, you get unexpected 
results because the data is repeated for each period type. 

 

Portfolios. The Application Management domain includes portfolios (contents and 
properties). You can use the portfolios to filter and group the investment data by 
portfolio when building ad hoc views.  

In the Application Management domain, you are working with your actual up-to-date 
investment data (not a copy of the data as you use when doing portfolio planning in CA 
Clarity PPM).  

 

For example, you created a portfolio in CA Clarity PPM with 100 investments. In the 
Application Management domain, you add Investment Name to the ad-hoc view (drag 
Investment Name from Fields to Columns in the New Ad Hoc View). Then drag Portfolio 
Name (from Fields) to the Filters, select the portfolio (that you created with 100 
investments) from the drop-down, and click Apply. The ad hoc view now only shows the 
100 investments in that selected portfolio. In this way, you are using Portfolios as a 
filtering method of reporting on your investment data. 

 

You can also group your data by portfolio in the Application Management domain. For 
example, you want to see the Total EAC Hours for the investments in each portfolio. You 
add (drag) Investment Name from the Fields area to Columns in the New Ad Hoc View. 
Then you drag Total EAC Hours from the Investment Totals in the Measures area to 
Columns in the New Ad Hoc View. Then you add Portfolio Name (from Fields) to Groups 
in the New Ad Hoc View. Your data is shown organized by portfolio in the format you 
selected (table, chart, pie diagram). 
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In the Application Management domain, you are working with actual up-to-date 
investment data. You are not using a copy of the data as you use during portfolio 
planning in CA Clarity PPM. Therefore, the Application Management domain data does 
not match the data in the CA Clarity PPM portfolios that you use for portfolio planning. 
Portfolio planning uses a copy of the actual investment data.  

 

Custom Fields. If you have custom fields that are related to applications, these fields 
appear in a Custom folder in the Application Management domain. This domain can 
have multiple Custom folders. For example, Team custom fields appear in the Team 
Custom folder. 

 

Idea Management Domain 

The Idea Management domain contains information about the investments, teams, and 
financials that are related to Ideas. Fields that apply only to ideas are included in this 
domain. 

 

Domain Characteristics 

The following domain characteristics apply to this domain. 

The Idea Management domain contains two main types of data: investment-level 
financial data (summarized for the total Investment and divided into periods) and team 
data (at the team level and by calendar periods). The domain has general information, 
financial information, OBS information, and team information for all team members in 
an investment.  

The Idea Management domain does not have detailed Cost Plan or actual transaction 
detail data. See the Financial Management domain for that information. 

 

Do not mix object types when selecting from Fields and Measures. If you select 
Investment Name in the Fields area, select a total under the Investment Totals in the 
Measures area. Selecting a total from a different Measures object category (for 
example, Team Totals) could produce unexpected results. For Investment data, use 
investment fields and investment measures. To use Team data when creating an ad hoc 
view, select a team member field from the Team folder under Fields and use a team 
amount from the Team folder under Measures. In general, use Investment data (Fields) 
with Investment metrics (Measures) and use Team data (Fields) with Team metrics 
(Measures). 

Use Team data when you want specific data about a team and its members (for 
example, resources or allocation start dates). However, for Baseline hours, do not use 
Team data. You can find total Baseline hours summed under Investment data.  

 



Advanced Reporting Domains 

 

Chapter 14: Advanced Reporting  129  
 

Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making ad hoc view selections. For example, use 
calendar period measures (Measures area) for calendar period fields (Fields area) and 
use fiscal period measures (Measures section) for fiscal period fields (Fields section). 
Also, do not mix the period types (week, calendar, fiscal). Otherwise, you get 
unexpected results because the data is repeated for each period type. 

 

Portfolios. The Idea Management domain includes portfolios (contents and properties). 
You can use the portfolios to filter and group the investment data by portfolio when 
building ad hoc views.  

 

For example, you created a portfolio in CA Clarity PPM with 100 investments. In the Idea 
Management domain, you add Investment Name to the ad-hoc view (drag Investment 
Name from Fields to Columns in the New Ad Hoc View). Then drag Portfolio Name (from 
Fields) to the Filters, select the portfolio (that you created with 100 investments) from 
the drop-down, and click Apply. The ad hoc view now only shows the 100 investments in 
that selected portfolio. In this way, you are using Portfolios as a filtering method of 
reporting on your investment data. 

 

You can also group your data by portfolio in the Idea Management domain. For 
example, you want to see the Total EAC Hours for the investments in each portfolio. You 
add (drag) Investment Name from the Fields area to Columns in the New Ad Hoc View. 
Then you drag Total EAC Hours from the Investment Totals in the Measures area to 
Columns in the New Ad Hoc View. Then you add Portfolio Name (from Fields) to Groups 
in the New Ad Hoc View. Your data is shown organized by portfolio in the format you 
selected (table, chart, pie diagram). 

 

In the Idea Management domain, you are working with actual up-to-date investment 
data. You are not using a copy of the data as you use during portfolio planning in CA 
Clarity PPM. Therefore, the Idea Management domain data does not match the data in 
the CA Clarity PPM portfolios that you use for portfolio planning. Portfolio planning uses 
a copy of the actual investment data.  

 

Custom Fields. If you have custom fields that are related to ideas, these fields appear in 
a Custom folder in the Idea Management domain. This domain can have multiple 
Custom folders. For example, Team custom fields appear in the Team Custom folder. 

 

Project Management Domain 

The Project Management domain contains information about projects and programs 
that are related to the Project object. This information includes investments, teams, 
financials, issues, risks, and change requests. Change requests include metrics (under 
Measures), but issues and risks do not include metrics. This domain also contains tasks 
and assignments, with summary-level data (totals) for both objects. The financial 
attributes in this domain are project summary level and not cost plan level. You can find 
the detailed financial information at the cost plan level in the Financial Management 
domain. 
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Custom attributes and subobjects for the investment and project objects are included in 
this domain. They appear combined in a Custom set. No distinction exists between the 
attributes and subobjects that belong to the investment and those that belong to the 
project.  

This domain includes properties that apply specifically to the Project object. These 
properties appear in the General set.  

 

The Portfolio properties are used for filtering projects by portfolios. You can see the 
projects that are associated with each portfolio. This domain does not contain 
aggregated data. 

 

Domain Characteristics 

The following domain characteristics apply to this domain. 

The Project Management domain contains two main types of data: investment-level 
financial data (summarized for the total Investment and divided into periods) and team 
data (at the team level and by calendar periods). The domain has general information, 
financial information, OBS information, and team information for all team members in 
an investment.  

The Project Management domain does not have detailed Cost Plan or actual transaction 
detail data. See the Financial Management domain for that information. 

 

Do not mix object types when selecting from Fields and Measures. If you select 
Investment Name in the Fields area, select a total under the Investment Totals in the 
Measures area. Selecting a total from a different Measures object category (for 
example, Team Totals) could produce unexpected results. For Investment data, use 
investment fields and investment measures. To use Team data when creating an ad hoc 
view, select a team member field from the Team folder under Fields and use a team 
amount from the Team folder under Measures. In general, use Investment data (Fields) 
with Investment metrics (Measures) and use Team data (Fields) with Team metrics 
(Measures). 

Use Team data when you want specific data about a team and its members (for 
example, resources or allocation start dates). However, for Baseline hours, do not use 
Team data. You can find total Baseline hours summed under Investment data.  

Note: If you want to add a task to an ad hoc view and you want to view the data by 
resource and task, add the Assignment Resource to the view. If you add the Team 
Resource (instead of the Assignment Resource), the resulting data is inaccurate. If you 
want to view team data (without task data) by resource, add the Team Resource to the 
view. 
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Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making ad hoc view selections. For example, use 
calendar period measures (Measures area) for calendar period fields (Fields area) and 
use fiscal period measures (Measures area) for fiscal period fields (Fields area). Also, do 
not mix the period types (week, calendar, fiscal). Otherwise, you get unexpected results 
because the data is repeated for each period type. 

 

Portfolios. The Project Management domain includes portfolios (contents and 
properties). You can use the portfolios to filter and group the investment data by 
portfolio when building ad hoc views.  

In the Project Management domain, you are working with your actual up-to-date 
investment data (not a copy of the data as you use when doing portfolio planning in CA 
Clarity PPM).  

 

For example, you created a portfolio in CA Clarity PPM with 100 investments. In the 
Project Management domain, you add Investment Name to the ad-hoc view (drag 
Investment Name from Fields to Columns in the New Ad Hoc View). Then drag Portfolio 
Name (from Fields) to the Filters, select the portfolio (that you created with 100 
investments) from the drop-down, and click Apply. The ad hoc view now only shows the 
100 investments in that selected portfolio. In this way, you are using Portfolios as a 
filtering method of reporting on your investment data. 

 

You can also group your data by portfolio in the Project Management domain. For 
example, you want to see the Total EAC Hours for the investments in each portfolio. You 
add (drag) Investment Name from the Fields area to Columns in the New Ad Hoc View. 
Then you drag Total EAC Hours from the Investment Totals in the Measures area to 
Columns in the New Ad Hoc View. Then you add Portfolio Name (from Fields) to Groups 
in the New Ad Hoc View. Your data is shown organized by portfolio in the format you 
selected (table, chart, pie diagram). 

 

In the Project Management domain, you are working with actual up-to-date investment 
data. You are not using a copy of the data as you use during portfolio planning in CA 
Clarity PPM. Therefore, the Project Management domain data does not match the data 
in the CA Clarity PPM portfolios that you use for portfolio planning. Portfolio planning 
uses a copy of the actual investment data.  

 

Custom Fields. If you have custom fields that are related to projects, these fields appear 
in a Custom folder in the Project Management domain. This domain can have multiple 
Custom folders. For example, Team custom fields appear in the Team Custom folder. 

 

Resource Management Domain 

The Resource Management domain includes information about investments, resources, 
teams and assignments, and task fields from the resource perspective. 
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Domain Characteristics 

The following domain characteristics apply to this domain. 

Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making ad hoc view selections. For example, use 
calendar period measures (Measures area) for calendar period fields (Fields area) and 
use fiscal period measures (Measures area) for fiscal period fields (Fields area). Also, do 
not mix the period types (week, calendar, fiscal). Otherwise, you get unexpected results 
because the data is repeated for each period type. 

 

Time Management Domain 

The Time Management domain contains information about created timesheets and 
missing timesheets. Use this domain if you are managing timesheets. This domain 
provides timesheet details at the date worked level. All created timesheets for all 
statuses are included in this domain. Incidents are also included in this domain. 

Note: This domain does not contain aggregated hours for a project or investment. For 
aggregated data, use the Investment Management domain. 

If you do not use timesheets in CA Clarity PPM for timekeeping, you can see the fields in 
this domain, but the fields have no data. 

 

Domain Characteristics 

The following domain characteristics apply to this domain. 

Missing Timesheets. This domain includes missing timesheets. You can view a specific 
resource by period and you can see the timesheets that were not created for that 
resource. The domain does not include missing time entries on a created timesheet. 

If you forgot to create an entire timesheet for a given time period, that missing 
timesheet appears under Missing Time (in the Fields area). However, if you forgot to 
complete some of the time entries on an existing timesheet, those time entries do not 
appear under Missing Time. To see all time entries (entered hours and missing entries) 
in existing timesheets, look under the Timesheets set. Any missing time entry from an 
existing timesheet appears there. 
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Financial Management Domain 

The Financial Management domain lets financial managers view financial data. This 
domain includes OBS and Investment data. The domain includes only fiscal time periods 
(not calendar or weekly time periods). All metrics (under the Measures area of the Ad 
Hoc Viewer/Editor) are fiscal. 

This domain contains detailed financial planning data, including cost plans, cost plan 
details, benefit plans, benefit plan details, and WIP transaction details (at the 
transaction level). The domain includes the data at a plan level (in the Financial Plans set 
under Investments in the Fields area of the Ad Hoc View/Editor). You can view the data 
for an actual plan of record or an actual Benefits plan. 

 

This domain does not include Invoicing or Chargeback data. 

Note: Some of this financial planning data is also available in the Investment 
Management domain as a subset of the investment data. 

If you do not use Financial Management, you can see the fields in this domain, but the 
fields have no data. 

 

Domain Characteristics 

The following domain characteristics apply to this domain. 

The Financial Management domain includes detailed financial planning data under 
Financial Plans. The domain also includes break-ups, such as charge codes. WIP 
transaction data is included at the transaction level. A row is included for every 
transaction (at the detail level not at the summary level). 

Do not mix metric types when selecting from Fields and Measures. If you select a total 
under the Investment Totals in the Measures area, do not also select a Transaction 
Measure under the WIP Transactions in the Measures area. This combination could 
produce unexpected results. When selecting a Measure in the Financial Management 
domain, select either Investment Totals or WIP Transactions, but not both 
simultaneously. 

 

You cannot look at the investment-level summary financial data using the detailed 
financial planning metrics. In the detail level, you have a row of data for each financial 
plan. All the financial plans for a project are available. To view only the POR plan data, 
for example, use the filter. Otherwise, you get duplicated or triplicated numbers. 

Data that is shown under Investment Totals (Measures area) is investment-level data. 
Data that is shown under Financial Plans or Fiscal Periods (Fields area) is detail-level 
data. Data that is shown under WIP Transactions (Fields and Measures areas) is 
transaction-level data. Data that is not shown under Fiscal periods is total 
(summary/investment level) data. 
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Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making selections. For example, use calendar period 
measures (Measures area) for calendar period fields (Fields area) and use fiscal period 
measures (Measures area) for fiscal period fields (Fields area). Also, do not mix the 
period types (week, calendar, fiscal). Otherwise, you get unexpected results, because 
the data is repeated for each period type. 

 

Project Plans. As you include financial plans in your Ad Hoc View, you notice that there 
are multiple plans for each investment project. You do not only see the plan of record. 
You see all plans for the investment. To view only the plan of record, use a filter. 

 

Custom Fields. If you have custom fields that are related to financial planning, these 
fields appear in a Custom folder in the Financial Management domain. This domain can 
have multiple Custom folders. For example, Team custom fields appear in the Team 
Custom folder. 

 

Custom Master Objects Domain 

The Custom Master Objects domain contains information about custom master objects 
and their child objects. This domain also includes the Language subobject and fields. 
Your administrator makes these objects Data Warehouse enabled, and they are then 
included in the Custom Master Objects domain.  

Note: Custom Master Objects do not have parent objects and so are not related to any 
other objects in CA Clarity PPM. 

 

Domain Characteristics 

The following domain characteristics apply to this domain. 

This domain contains custom master objects and their children. These objects are not 
related to any other object in CA Clarity PPM. Each custom object has a corresponding 
set in this domain. The custom object name is also the set name. The objects in this 
domain are not related to each other. 

View one custom master object at a time. When you select the Custom Master Object 
domain for viewing in the Ad Hoc Viewer/Editor, select one of the custom master 
objects to view. You cannot view data for multiple custom master objects 
simultaneously, because the custom master objects do not have relationships with each 
other. 
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Do not mix calendar types. When you look at periodic data (for example, monthly data), 
do not mix calendar types when making selections. For example, use calendar period 
measures (Measures area) for calendar period fields (Fields area) and use fiscal period 
measures (Measures area) for fiscal period fields (Fields area). Also, do not mix the 
period types (week, calendar, fiscal). Otherwise, you get unexpected results because the 
data is repeated for each period type. 
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Chapter 15: How to Run or Schedule a 
Report 
 

This section contains the following topics: 

Security for Reports (see page 137) 
Run or Schedule a Report (see page 138) 
Edit Scheduled Report Run Properties (see page 139) 
Manage a Scheduled Report Run (see page 140) 
View a Generated Report (see page 141) 
Delete Generated Reports (see page 142) 
Jobs Affecting Report Information (see page 142) 

 

Security for Reports 

Security for reports has three levels. The following table describes each level of access. 
The CA Clarity PPM administrator grants you the access rights to specific features. 

 

Access Level Description 

Report access Allows you to view reports. When you have access at 
this level, you can open the Available Reports page. 
The Reports - Access right includes this level of 
access. 

You can be granted instance access rights to view and 
run a specific report. The Report - Run access right 
lets you run a report and view the output. This access 
right does not let you change the parameters that 
filter information for a report. 

Report definition Allows you to edit a specific report definition. When 
you have this level of access, you can change the 
report parameters to filter information for a report. 
The Reports and Jobs - Edit Definition instance access 
right lets you edit a specific report definition. 
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Row-level security within a 
report 

This access level helps ensure that information is 
provided to you if you have the right to view the 
information. The row content that appears in each 
report varies depending on the access rights you 
have to items contained in the report. For example, if 
you run a report that lists information for multiple 
projects, only those projects to which you have rights 
appear in the report. 

Run or Schedule a Report 

The Available Reports page lists all reports that a user or administrator can access and 
can run immediately or can schedule to run later. The report type is the user view of the 
report definition. Each available report has a corresponding definition and one report 
type. From this view, you can select a report type and can set the run criteria. You 
cannot delete or remove available reports. 

The scheduled report runs let you set up recurring schedules for your frequently viewed 
reports. By scheduling the reports to run in advance, the updated reports are available 
when you need them. 

Note: If you have personalized the Overview page to display the My Reports portlet, you 
can add and run any available report from this portlet. 

 

 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Specify the filter criteria, or click Show All to view a list of all available reports. 
 

3. Click the name of the report you want to run or schedule. 

4. Complete the requested information. The following sections require explanation: 

General 

Edit the report name. For scheduled runs, you can change the name to 
distinguish each instance of a run. For example, Retailing Banking - Monthly 
Rate Extraction run. 

For submitted scheduled report entries, a read-only job ID and status are 
displayed. 

 

Parameters 

Set the parameters as desired. This section appears only if your CA Clarity PPM 
administrator defined the parameters. Click Save Parameters to save the 
defined set of parameters for reuse. The saved parameters display in the list on 
the Available Jobs list page below the report type from which it is based. 
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When 

Defines the interval on which the report runs. 

Select Scheduled to run the report later. To run the report at a recurring time, 
click the Set Recurrence link. 

You can also set the recurrence of a scheduled report by using the UNIX 
Crontab. To use crontab, select Use UNIX Crontab Entry Format and enter the 
schedule. For example, the following statement indicates that the report runs 
at midnight on the 1st and 15th of every month. 

0 0 1,15 * *  
 

You can use the crontab option on Windows, Linux, and UNIX operating 
systems where the CA Clarity PPM instance is running. When you use this 
option, the scheduled configuration takes the server system time where the CA 
Clarity PPM instance is running. 

Note: For more information about the UNIX Crontab format and special 
character usage, see the Oracle Documentation. 

 

5.  Submit your changes. 
 

Edit Scheduled Report Run Properties 

Report run properties include scheduling and notification information, and any 
parameters that you can customize. The Scheduled Reports page lists the scheduled 
report run times and report run statuses a user or administrator has created. A single 
report can have many scheduled runs. All scheduled report runs (except the deleted 
reports) appear in the list regardless of their status. 

You can edit the properties of scheduled report runs that have the Canceled or 
Completed status using the Report Properties page. Otherwise, you can only view report 
run properties. 

 

A scheduled report run can have one of the following statuses: 

■ Canceled. The scheduled run is stopped and future recurring runs permanently 
canceled. 

■ Completed. The single, nonrecurring scheduled run is complete and the generated 
report output is available. 

Note: Recurring scheduled runs never show a Completed status. 
 

http://docs.oracle.com/
http://docs.oracle.com/
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■ Paused. The scheduled run is stopped temporarily. 

■ Running. The scheduled run is in progress. 

■ Scheduled. The scheduled run starts generating the report on its prescribed date 
and time. 

■ Waiting. The scheduled run cannot start generating the report until an incompatible 
report or job run is completed. 

Note: If you schedule a report to run only once, you can only edit its properties before 
the scheduled run time. 

 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Reports menu, and click Scheduled Reports to edit the schedule of an 
existing report run. 

 

3. Click the name of the report you want to edit. 

4. Edit the information and save your changes. 

Note: If a report fails, check the status of scheduled runs for more information or 
contact your administrator for any assistance. 

 

Manage a Scheduled Report Run 

You can manage a scheduled report run in the following ways: 

■ Pause or resume a scheduled report run 

Pausing scheduled report runs temporarily stops the report from running. When in 
this state, the report cannot run at its scheduled time until you resume the report 
run. When you resume the report runs, it runs at its next scheduled run time. You 
can pause reports that have a Scheduled status. 

 

■ Cancel a scheduled report run 

Canceling scheduled runs stops the run immediately and cancels any future runs. A 
cancelled run remains listed on the scheduled reports page with a status Cancelled 
status. Once you cancel a run, you cannot change its status or cannot edit any of its 
properties. 

 

■ Delete a scheduled report run 

You can delete scheduled runs with a Cancelled or Completed status. Deleting a 
scheduled run does not delete the report type, or any completed generated reports 
that are listed in the Reports Library. 
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Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Reports menu, and click Scheduled Reports. 

3. Select the check box next to the scheduled report and complete one of the 
following actions: 

■ Click Pause. 

■ Click Resume.  

■ Click Cancel Job. 

■ Click Delete Job. 
 

View a Generated Report 

The Report Library page lists all the generated reports a user has access to view. The 
report instance is the output that is generated from a scheduled run. Reports run 
immediately and can be viewed immediately after they are generated. You can also save 
and share reports with others.  

 

If the scheduled report run recurs, then an instance of the report log is generated for 
each recurrence. For example, if a scheduled report run is set to recur monthly, then an 
instance of that report is created each month. 

 

You must have Adobe Acrobat Reader installed to view reports.  
 

Note: For any reports that run immediately, you can view the report immediately. You 
can also save the report and view it later from the Report Library page. 

 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Reports menu, and click Report Library. 
 

3. Complete any one of the following steps: 

■ Click the Open Report icon next to the report to review. 

■ Click the Report link to view run properties. 
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Delete Generated Reports 

You can delete generated reports as needed. You can also schedule the Remove Job 
Logs and Report Library entries job run to remove outdated reports from the Reports 
Library periodically. 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Reports menu, and click Report Library. 
 

3. Select the check box next to the report, and click Delete. 
 

Jobs Affecting Report Information 

The Setup and Update Data Used by Reports and the Time Slicing jobs generate the 
report information. If these jobs fail, reports can be affected. If the report information 
does not display, it implies that one of the jobs have failed to run. 

Contact your CA Clarity PPM administrator for more information. 
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Chapter 16: How to Run or Schedule a Job 
 

This section contains the following topics: 

Statuses for Scheduled Job Runs (see page 143) 
Run or Schedule Jobs (see page 144) 
Edit Scheduled Job Run Properties (see page 145) 
Manage a Scheduled Job Run (see page 145) 
View or Delete the Job Log (see page 146) 

 

Statuses for Scheduled Job Runs 

Jobs are sets of actions that the application uses to perform automated administrative 
processes regularly. For example, jobs can populate or refresh database tables and run 
background processes. A job can be composed of queries, statements, or procedures. 

Use the Scheduled Job page to view the run times of a job and the run status. All 
scheduled runs (except deleted ones) are listed regardless of their status. A scheduled 
run can have one of the following statuses: 

Cancelled 

Indicates that the scheduled run was stopped and future recurring runs 
permanently cancelled. 

 

Completed 

Indicates that the single, nonrecurring scheduled run has completed. If the job 
definition is set to generate a log, you can view it in the Job Log. 

Note: Recurring scheduled runs never show a status of Completed. 
 

Paused 

Indicates that the scheduled run is stopped temporarily. 

Running 

Indicates that the scheduled run is in progress. 
 

Scheduled 

Indicates that the scheduled run starts executing the job on its prescribed date and 
time. 

 

Waiting 

Indicates that the scheduled run has reached its scheduled run date and time, but 
cannot start executing the job until an incompatible report or job completes 
running. 
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Pending for Process Engine 

Indicates that the status appears only if the process engine is not run before the 
Assign Incident job is run. 

 

Run or Schedule Jobs 

The Available Jobs page list all jobs that a user or administrator can access and can run 
immediately or can schedule it to run later. The report type is the user view of the 
report or job definition. Each available job has one corresponding definition and one job 
type.  

 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Jobs menu, and click Available Jobs.  
 

3. Click the name of the job you want to run or schedule. 

4. Complete the requested information. The following sections require explanation: 

General 

Edit the job name. For scheduled runs, you can change the name to distinguish 
each instance of a run. For submitted scheduled job entries, a read-only job ID 
and status are displayed. 

 

Parameters 

Set the parameters as desired. This section appears only if your CA Clarity PPM 
administrator defined the parameters. Click Save Parameters to save the 
defined set of parameters for reuse. The saved parameters display in the list on 
the Available Jobs list page below the job type from which it is based. 

 

When 

Defines the interval at which the job runs. Select Scheduled to run the job later. 
To run the job at a recurring time, click the Set Recurrence link. 

You can also set the recurrence of a scheduled job using the UNIX crontab. To 
use crontab, select Use UNIX Crontab Entry Format and enter the schedule. For 
example, the following entry indicates that the job runs at midnight on the 1st 
and 15th of every month. 

0 0 1,15 * * 

You can use the crontab option on Windows, Linux, and UNIX operating 
systems where the CA Clarity PPM instance is running. When you use this 
option, the scheduled configuration takes the server system time where the CA 
Clarity PPM instance is running. 

Note: For more information about the UNIX Crontab format and special 
character usage, see the Oracle Documentation. 

 

http://docs.oracle.com/
http://docs.oracle.com/
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5.  Submit your changes. 
 

Edit Scheduled Job Run Properties 

The Scheduled Jobs page lists the run times of a job and the run status. All scheduled 
runs (except deleted ones) are listed regardless of their status. Using the Job Properties 
page, you can edit the properties of scheduled job runs that have statuses as Canceled 
or Completed. Otherwise, you can only view job run properties. 

Note: If you schedule a job to run only once, you can only edit its properties before the 
scheduled run time. 

 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Click the Jobs menu, and click Scheduled Jobs to edit the schedule of an existing job 
run. 

 

3. Click the name of the job you want to edit. 

4. Edit the information and save your changes. 

Note: If a job fails, check the status of scheduled runs for more information or 
contact your administrator for any assistance. 

 

Manage a Scheduled Job Run 

You can manage a scheduled job run in the following ways: 

■ Pause or resume a scheduled job run 

On the Scheduled Jobs page, you can pause any job with a status of Scheduled and 
can resume the job. You can pause a job run to stop temporarily from running. 
When in this state, the job cannot run at its scheduled time until you resume it. 
When you resume the job, it runs at its next scheduled run time. 

 

■ Cancel a scheduled job run 

You can cancel a schedule job run to stop the job immediately and cancel any future 
runs, but continues running in the background. A canceled job remains in the 
scheduled jobs list with a Canceled status. The status takes some time to reflect in 
the Scheduled Jobs list page. After you cancel a job run, you cannot change its 
status or cannot edit any of its properties. 

 

■ Delete a scheduled job run 

You can delete the scheduled job runs with a Canceled or Completed status using 
the Scheduled Jobs page. Deleting scheduled runs does not delete the job type, or 
any of the run job logs. 
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Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Jobs menu, and click Scheduled Jobs. 
 

3. Select the check box next to the scheduled job and complete one of the following 
actions: 

■ Click Pause. 

■ Click Resume.  

■ Click Cancel Job. 

■ Click Delete Job. 
 

View or Delete the Job Log 

You can use the Log page to view information about a job run or delete outdated job 
logs. A job log consists of a read-only version of its run properties and lists job entries, 
times, and any messages. If a job fails, the log indicates the nature of the error.  

You can schedule the Remove Job Logs and Report Library entries job to remove job logs 
and report instances periodically from the Report Library or Job Log. 

 

Follow these steps: 

1. Open Home, and from Personal, click Reports and Jobs. 

2. Open the Jobs menu, and click Log. 
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Appendix A: Keyboard Shortcuts 
 

This section contains the following topics: 

Keyboard Shortcuts for Basic Features (see page 147) 
CA Clarity Keyboard Shortcuts (Actions) (see page 147) 
CA Clarity Keyboard Shortcuts (Lists) (see page 148) 
Keyboard Shortcuts for Time-Scaled Value Cells (see page 149) 

 

Keyboard Shortcuts for Basic Features 

The following table shows the keyboard shortcuts for basic features available on all CA 
Clarity PPM pages. 

  

Feature Key Combination 

Home Menu Ctrl+Alt+H 

Administration Menu Ctrl+Alt+A 

Favorites Menu Ctrl+Alt+F 

Back Ctrl+Alt+B 
or 
Alt+Left Arrow 

Home Page Ctrl+Alt+Home 

Refresh Ctrl+Alt+F5 

Search Ctrl+Alt+S 

History Ctrl+Alt+V 

Help F1 
 

CA Clarity Keyboard Shortcuts (Actions) 

The following table shows keyboard shortcuts for actions on CA Clarity PPM pages. 

 

Action Key Combination Alternate Accessibility 
Key Combination 

Activate a field editor (for example, a 
date picker) 

Enter Alt+Enter 
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Action Key Combination Alternate Accessibility 
Key Combination 

Close a popup Esc Shift+Esc 

Open a tab menu Enter Alt+Enter 

Move left, right, up, or down in a menu Left Arrow 
Right Arrow 
Up Arrow 
Down Arrow 

Alt+Up Arrow 
Alt+Down Arrow 
Alt+Up Arrow 
Alt+Down Arrow 

Select a highlighted menu item Enter Alt+Enter 

Open a link in a list page Ctrl+Enter  

Select or clear a check box 
Note: Focus must be on the checkbox. 

Space Bar  

Expand a hierarchical list 
Note: Focus must be on the + in the 
hierarchical list. 

Space Bar  

 

CA Clarity Keyboard Shortcuts (Lists) 

The following table shows the keyboard shortcuts for lists. 

  

Action Mode Keyboard Combination 

Switch between edit and display 
mode in a list 

Display, Edit Enter 

Move from cell to cell through a list 
(grid)  

Display 

 

Left Arrow 
Right Arrow 
Up Arrow 
Down Arrow 

Move to different areas within a 
list: portlet icons, column headers, 
body of list, buttons 

Display Tab (Forward) 
Shift+Tab (Back) 

Switch to display mode Edit Esc or Enter 

Move left or right within a cell Edit Left Arrow 
Right Arrow 

Move from editable cell to editable 
cell 

Edit Tab (Forward) 
Shift+Tab (Back) 
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Action Mode Keyboard Combination 

Move to the end of a row 

Note: If the action is on a TSV row, 
repeat the keyboard combination 
to leave the TSV section. 

Edit Ctrl+Right Arrow 

Move to the beginning of a row Edit Ctrl+Left Arrow 

Page up or down Display, Edit Ctrl+Alt+Up Arrow 
Ctrl+Alt+Down Arrow 

Move to the top or bottom of a list 

Note: If the action is in a TSV cell, 
repeat the keyboard combination 
to leave the TSV section. 

Display, Edit Ctrl+Up Arrow 
Ctrl+Down Arrow 

Open a drop-down list or a date 
selector 

Edit Enter 

Move through selection items in a 
drop-down 

Edit Up Arrow 
Down Arrow 

Select a highlighted value in a 
drop-down or a date selector 

Edit Enter 

Highlight a date in a date selector Edit Down Arrow 

Add a new line in a long text area Edit Ctrl+Enter 
 

Keyboard Shortcuts for Time-Scaled Value Cells 

The following table shows the keyboard shortcuts for time-scaled value cells in a list. 

 

Action Key Combination Alternate 
Accessibility Key 
Combination 

Select a TSV row Shift+Ctrl+Right Arrow  

Select a TSV column Shift+Ctrl+Down Arrow  

Select a single cell to the left or 
right of the current cell 

Shift+Right Arrow 
Shift+Left Arrow 

 

Select a single row above or 
below the current cell 

Shift+Up Arrow 
Shift+Down Arrow 

 

Copy a TSV cell Ctrl+c  

Paste a TSV cell Ctrl+v  
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Action Key Combination Alternate 
Accessibility Key 
Combination 

Cut a TSV cell Ctrl+x  

Undo a cut, copy, or paste 
operation 

Ctrl+z  

Copy from Excel to a TSV cell Ctrl+c and Ctrl+v  
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